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INTRODUCTION 

 
Through the 100,000 Homes Campaign, Community Solutions has worked with hundreds of 

local teams to place 100,000 of the most vulnerable people experiencing homelessness into 

permanent housing. It has been a privilege to support their efforts to locate homeless individuals 

and families who are the most vulnerable and connect them as quickly as possible to housing 

that meets their needs and preferences. 

 
Using a Google platform, the Community Solutions team had built a tool to determine the needs 

and preferences of people experiencing homelessness and match them to the appropriate 

housing interventions, across multiple agencies for the 100,000 Homes Campaign. 

 
As Community Solutions continues to work with various municipalities both in the U.S. and 

internationally, we have continued to work with communities on creating a Google-based Data 

System in order for communities to track their registry week client assessments and analyze 

their client demographics. 

 
This document provides an overview of how you and your community can create your own 

Google-based Data System. The guide will review general (introductory) 

considerations/suggestions on the creation of your Google-based Data System and we will use 

a sample community’s registry week to share practical application to the general 

considerations/suggestions. More specifically, we will use the sample community’s 

Google-based Data System created to track it’s clients who are experiencing homelessness. 

 
If you are a community using the VI-SPDAT (Canadian version 2.0) common assessment and 

would like to use a preset data system that you can copy, please skip to PART VII: Premade 

VI-SPDAT 2.0 (CANADA) Data Platform. 

 
Lastly, in the spirit of quality improvement, we welcome any suggestions or comments on how 

this guide may be improved! Please feel free to contact hkim@cmtysolutions.org to share your 

feedback! 

mailto:hkim@cmtysolutions.org
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PART I: Overview of Google Account/Drive Docs Editors1
 

 
A. Creating a google account: If you do not yet have a google account, you may sign up for 

one here → https://accounts.google.com/SignUP 

 

B. Start by signing in to your account. 

1. Go to www.google.com and in the top-right corner, click Sign in. 

2. Enter your Google Apps email address (example: joe@company.com) and 

password. 

3. Click Sign in . 

 
Now that you’re in your Google Apps account, here are a few key features that work the same 

way across several products: 

 

 
 

C. The Google Drive2
 

your Google account. 

is an online file storage that is automatically attached with 

a. The Drive is where you may access the Google Docs Editors. 

i. Store any files or folders from your computer 

ii. Keep Drive organized with folders 

iii. Share files with your team 

iv. Remove, permanently delete, or restore files 

b. You may access your Drive: 

i. Using this link → drive.google.com 

ii. Or after signing in to your Google account, you may access your drive by 

clicking on the  icon on the top right-hand corner of your browser 

window, then clicking on the Drive icon. 

 
1 More information on Google products can be found on the Google Apps Learning Center website: 

https://apps.google.com/learning-center/products/quickstart/#step-1 
2   For more info on the Drive:    https://apps.google.com/learning-center/products/quickstart/#step-4 

https://accounts.google.com/SignUP
http://www.google.com/
https://drive.google.com/
https://apps.google.com/learning-center/products/quickstart/#step-1
https://apps.google.com/learning-center/products/quickstart/#step-4
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D. The Drive is where you may also create, edit, and access the Google Docs Editors3. 

The Docs Editors are collaborative, web-based, “applications” - where each application 

functions for different purposes: 

 

 
E. For the purposes of this How-To Guide, we will be focusing mainly on the following three 

Docs Editors applications: 

a. Google Docs 

b. Google Sheets 

c. Google Forms 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   For more info on Docs Editors:    https://apps.google.com/learning-center/products/quickstart/#step-5 

https://apps.google.com/learning-center/products/quickstart/#step-5
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PART II: Understanding Your System Needs 

 
Before jumping in to using your Google account and creating your system, there are some 

questions for considerations. Below, we have listed out some questions for consideration prior 

to designing and creating your data system. At the bottom of each question section, we have 

inserted example responses for a sample community conducting a Registry Week (RW)4 as a 

reference for how these questions may facilitate with data system creation. 

 
System Needs: Questions for Consideration 

 
A. What would you like your data system to do/capture? Why and to what end/purpose? 

 

These questions may yield multiple sets of responses and you may also find that some 

responses come later on in the process. Depending on what you would like your data system to 

do will influence the data your community may need to obtain, and in turn, can affect the way in 

which you create your system. Below are some examples of data that communities may 

want/need to capture. A data system that: 

● Houses raw client common assessment responses - in order to identify and enumerate 

as many people as possible experiencing homelessness. to analyze trends/potential 

needs amongst those who are experiencing homelessness in the community, to identify 

the most vulnerable in the community in order to permanently house them as quickly as 

possible. 

● Surveys different providers’ housing placement rates over X amount of time - in order to 

analyze the rate in which clients are being housed and assess trends of housing 

placements over time, to advocate for more support services and funding for the 

community. 

● Have a system where case managers can input/track their clients’ progress to housing - 

so that case managers can easily assist/track clients with securing documents for 

housing, additional benefits and needs, etc., 

● Have a system where clients can be matched to housing placement opportunities - so 

that there is less subjectivity on matching clients to available units and 

systematizing/improving the process in which clients are housed 

 
Once you identify the data that you would like to capture through your system, you may want to 

prioritize that list based off of current need/capacity/etc. 

 
Responses for sample community conducting RW: A data system that houses raw client 

VI-SPDAT responses - in order to identify and enumerate as many people as possible 

experiencing homelessness. 

 

4 For more info on ‘Registry Weeks’: 

http://100khomes.org/sites/default/files/images/Registry%20Week%20PIT%20Integration%20Toolkit_FINAL. 

pdf 

http://100khomes.org/sites/default/files/images/Registry%20Week%20PIT%20Integration%20Toolkit_FINAL.pdf
http://100khomes.org/sites/default/files/images/Registry%20Week%20PIT%20Integration%20Toolkit_FINAL.pdf


Page  |  7 
 

B. What data needs to be collected for the data system? 

 

Depending on how you answered the previous questions, there may be one source of data (e.g. 

a common assessment) or multiple sources of data (e.g. common assessment, housing 

placement survey, nonprofit case management list, etc) that needs to be collected. 

 
Responses for sample community conducting RW: VI-SPDAT assessments and lists of 

people who refused/didn’t complete the VI-SPDAT 

 
C. Who are we getting the data from? 

 

Responses for sample community conducting RW: Interviewees - persons experiencing 

homelessness at the time of survey 

 
D. When will this/these data be collected? 

 

Responses for sample community conducting RW: 

Registry Week will be from January 3 - 7, 2016 from 1:00am - 5:00am. 

RW Data Entry will be from January 4 - 8, 2016 from 8:00am - 1:00pm. 

 
E. How will this data be collected? 

 

Responses for sample community conducting RW: X number of volunteers will be using the 

VI-SPDAT paper version or the VI-SPDAT google form version via web-connected tablet/smart 

phone (e.g. iPad / iPhone) 

 
F. Who needs to be involved with the various aspects of the data system? 

 

You may want to think about who will have to be involved with the different aspects of your data 

system. This may help with getting the right people on board from the beginning and ensuring 

that there is a smooth process in place to get your system up and running. For example, who 

will: 

1. Create this data system, 

2. Collect the data, 

3. Input the data (data entry), 

4. Clean up the data, 

5. Analyze the data / prep analysis for sharing (e.g. visualization), 

6. Share/present the data, 

7. The data be shared with, 

8. Etc (additional roles may come up depending on the data need) 
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G. Data Analysis Questions: 
 

Thinking through some data analysis questions may facilitate with how you create your data 

system. It may also help to ensure that gaps in data collection and planning are recognized as 

early as possible to mitigate supplemental work that can be avoided. 

 
1. What pieces of data need to be analyzed? 

2. Are the appropriate data being collected for analysis needs? (e.g. Do any additional 

questions need to be asked? Are there any unnecessary questions?) 

3. What pieces of data need to be aggregated for analysis? 

4. What type(s) of analysis is/are needed? (e.g. descriptive, exploratory, inferential, 

predictive, etc.) 

5. What is/are the purpose(s) for data analysis? 

6. Will the analysis be presented? If so, how will it be presented? Will the analysis need to 

be visualized? 

 
Other Data Need Considerations 

 
You may also want to consider any future system components and data tracking components 

that may be linked to your initial data system. Below are bullets of specific potential system 

components that you may want to consider: 

 
● Overall campaign aim (e.g. 20,000 homes campaign - tracking overall number of clients 

housed) 

● Campaign goal tracking (aggregate of communities data) and visualization of data 

● Tracking quality by-name list (BNL) 

● Tracking levels of and 'improvements' to community's CES (coordinated entry system) 

● Tracking of communities baseline and housing placement rate over time 

● Tracking # of people housed by communities 

● CES and Data reporting/quality relationship 

● Reporting trends of communities to campaign level 

● Housing placement improvement needs based off data 

● Other: communication strategy and scaling successes 

● Etc. 
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PART III: Creating Your Common Assessment on Google Forms 

 
PART III, will review how you can create/access the following three items: 

1. A Google Form: EDIT version - accessible to the creator/editor of the Form (and a 

limited number of other collaborators) 

2. A Google Form: LIVE version - accessible to data entry persons (where the URL link 

can be accessed by multiple people simultaneously) 

3. A Form Response Spreadsheet - this is a google spreadsheet where all the raw data 

from your google form is housed 

 
The steps below review how you can create a common assessment on Google Forms. You may 

also follow these steps to create other types of Google Forms (such as a housing placement 

form). 

 
Your community will be using a common assessment survey that captures information about 

surveyed people experiencing homelessness in your community. This guide we will be using 

this Canadian version of the Vulnerability Index - Service Prioritization Decision Assistance Tool 

(VI-SPDAT) common assessment as an example to show the steps. 

 
Once you have a finalized common assessment questionnaire such as the VI-SPDAT for your 

community, you can transfer the questionnaire on to Google Forms. 

 
Step 1: Creating a Google Form5

 

 
Create a new google form by either: 

● Going to forms.google.com and clicking the “+” button near the top of the screen to 

“create a new form” or 

● In Drive, click NEW and select Google Forms. (You can find additional file types under 

More.) 

 
After you create your new Google Form, your new Form should look something like the images 

pasted below. When you create your new Form, you are automatically in the EDIT version of the 

Form, meaning that this is where the Form questionnaire will be created and edited: 

 
 
 
 
 
 
 
 
 
 

 

5      https://support.google.com/docs/answer/87809?hl=en&ref_topic=6063584 

https://drive.google.com/file/d/0B0L-3OLIyBxLTk9EOXZRSzZSaUU/view?usp=sharing
https://drive.google.com/
https://support.google.com/docs/answer/87809?hl=en&amp;ref_topic=6063584
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New version of Google Forms Older version of Google Forms 

 

 
 

 

 
 
 
 

 

For this guide, we’ll be using the older version of Forms. If you have the newer version of Forms 

open, you can revert this to the older version by clicking on the “?” button at the bottom right 

corner of your window and clicking “Back to the old Forms”. 

 

 
 
 
 

Form Settings 

 

You will want to make sure that your ‘Form Settings’ are adjusted properly. Your Form Settings 

may look like this if your account is under a Professional/Business Google Account: 
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Or it may look like this with the basic/free Google Account: 

 
For either account types; you will want to have none of the checkboxes checked in and the 

ONLY checkbox that can be checked (if you prefer) is the one left of “Show progress bar at the 

bottom of form pages”. 

 
Form Title 

 

You will want to change the title of your Google Form. 

● ‘Title Name #1’ (in the image below) is the title for the EDIT version of your google form. 

This title is only viewable to the internal editors/collaborators of your google form (if any) 

who also have edit access. If you’d like to rename ‘Title Name #1’, you may do so by 

clicking on it directly. 

● ‘Title Name #2’ (in the image below) is the title that will show in the LIVE version of your 

form and will be viewable to those filling out the form such as your data entry persons. 

You may change Title Name #2 to your liking. 

 

And if you would like - you can also add a Form Description by clicking the grey ‘Form 

Description’ beneath ‘Title Name #2’. 
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Step 2: Creating Your Form Questions6
 

 
By default you should have an “Untitled Question” - this is your first question. You can click on 

the “Untitled Question” box and type in your first question from your common assessment onto 

your form. Beneath the first question that you had just created, click on the arrow next to the 

“Add item” button. You can now create the remainder of your Google Form questions. 

 

 
Question Types: 

● Text: People can provide short answers [advanced settings: data validation] 

● Paragraph text: People can provide longer answers [advanced settings: data validation] 

● Multiple choice: People can select one option from among several [advanced settings: 

shuffle option order] 

● Checkboxes: People can select as many options as they'd like [advanced settings: data 

validation; shuffle option order] 

● Choose from a list: People can select one option from a dropdown menu [advanced 

settings: shuffle option order] 

● Scale: People can rank something along a scale of numbers 

● Grid: People can select a point from a two-dimensional grid [advanced settings: limit to 

one response per column; shuffle row order] 

● Date 

● Time                         

Additional Notes on Question Items: 

The multiple choice and the checkboxes question types have an option of “Add ‘Other’” so that 

respondents may click ‘other’ and type in an alternate response that is different than the 

response options available. Please keep in mind, there may be questions where you will want to 

use this option - however, if respondents click other and do NOT type in an alternate response, 

then when you see the response for this submitted form, the Form Response Spreadsheet 

corresponding cell will appear empty. 

 
 

6      https://support.google.com/docs/answer/2839737?hl=en&ref_topic=6063584 

https://support.google.com/docs/answer/2839737?hl=en&amp;ref_topic=6063584
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The “Question Title” is generally where you will write your question. The “Help Text” is where 

you may add additional clarifying information about your “Question Title” if needed. You may 

also change the question item/type by clicking the drop down menu next to “Question Type”. 

 
Some questions items allow for advanced settings. You can access advanced settings by 

clicking the arrow left of “Advanced settings” which can be found toward the bottom of your item 

box when editing. You can make question items required, meaning that when a respondent 

wants to submit the form, they cannot do so unless they answer the required question. You can 

make a question required by checking off the box next to “Required question” which is to the 

right of the “Done” button in your item box. See image below. 

 

Important: Please keep in mind, when creating aggregate dashboards (instructions in PART IV: 

The Data Set, Analysis, & Creating Dashboards), you may decide to create dashboards that 

would pull from question items’ responses. Thus, if you plan on incorporating specific questions 

as part of your aggregate dashboard (particularly those with “text” and “paragraph text” question 

types), using specific help texts and/or advanced settings may help reduce latter data validation 

and dashboard formula issues. 

 
For example, a community using the Sample Community VI-SPDAT (CA V.2.0.) - 

5/27/16 google form, which is a Google Form replica of the paper version of Sample 

community’s VI-SPDAT (Canadian version 2.0) pdf document, may want to make the 

responses to VI-SPDAT question 2, “How long has it been since you lived in permanent 

stable housing?” as standard as possible in order to create a formula that will easily 

calculate their clients’ VI-SPDAT scores and calculate aggregate statistics about that 

particular question. To do so, the community has decided that responses should be a 

numerical value ONLY without text, thus, has decided to input help text for that question. 

See images below. 

https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://drive.google.com/a/cmtysolutions.org/file/d/0B0L-3OLIyBxLTk9EOXZRSzZSaUU/view
https://drive.google.com/a/cmtysolutions.org/file/d/0B0L-3OLIyBxLTk9EOXZRSzZSaUU/view
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Edit version of question 2 

 
Live version of question 2 

 
The community can use advanced settings: Data validation where the response must be 

a number greater than or equal to “0”, however, because the VI-SPDAT also allows for 

clients to refuse to respond to questions, the community has decided not to use data 

validation so that data entry persons can type in “refused” in the text box in the case that 

clients’ refused question 2. 

 
Section Headers & Page Breaks 

 

You may use “Section header” or “Page break” (from the “Add item” drop down options) to 

differentiate different sections of your questionnaire. For example, in the Sample Community 

VI-SPDAT (CA V.2.0.) - 5/27/16 google form, each domain (A. History of Housing and 

Homelessness, B. Risks, etc.) is separated using “Page break”. 

 
Step 3: Confirmation Page 

 
Once you’ve completed creating all of your Google Form questions, at the very bottom of your 

Google Form, you can edit the text in the “Confirmation Page” section where the text box 

defaults with the text “Your response has been recorded.” To edit, just click on this text. In 

addition, check off the boxes left of the three options to your liking. You may also allow data 

entry persons to edit responses after submitting. (Steps on editing responses are in Step 7: 

Data Entry of this guide). 

https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
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Step 4: Form Question Sequence 

 
Once you complete transferring over your common assessment to your newly created Google 

Form, you will want to double check that your questions are in the correct order. If they are not, 

you can click and drag the question item and move it accordingly in the EDIT version of your 

form. 

 
Step 5: Form Responses 

 
A. Choosing a form response destination7

 

 

When you create a new form, you will have to choose where your form responses will go. In 

your form, click “View responses” in the toolbar. Once you click “view responses”, a window will 

pop open, such as the one shown below. You will want to choose either I or II: 

I. New spreadsheet: Creates a new spreadsheet in Google Sheets for responses 

II. New sheet in an existing spreadsheet: Choose from your existing spreadsheets in 

Google Sheets to store responses 

 

 
 
 

 
7      https://support.google.com/docs/answer/2917686?hl=en&ref_topic=6063584 

https://support.google.com/docs/answer/2917686?hl=en&amp;ref_topic=6063584
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B. Checking Form Response Spreadsheet Column Sequence 

 

Your form response spreadsheet’ first row should have all of the question titles in the exact 

sequential vertical order of the edit version of your form for each question items created. 

 

 
If any question items on your google form were newly created, edited, rearranged, and/or 

deleted AFTER your form response spreadsheet was created, the sequence of questions in 

your responses spreadsheet may not be in the revised sequence you have on your google form 

(e.g. a deleted question may still appear in your responses spreadsheet; a newly created 

question may appear in the last column instead of it’s appropriate place). If this is the case, you 

will want to (a) UNLINK the form from the spreadsheet, (b) delete the unlinked spreadsheet, and 

(c) recreate a new spreadsheet for your responses so that the vertical sequence of questions in 

your google form are the exact same sequence in your form response spreadsheet (steps on 

unlinking and deleting your form response spreadsheet are below). 
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Please keep in mind that the first column of your form response spreadsheet will always house 

“timestamp” in column A. When a form is created, this is automatically generated (collects data 

on the exact date/time a data entry person clicks “submit” on the google form). 

 
We HIGHLY recommend that ALL edits to the google form be finalized BEFORE your google 

form is used for data entry of actual clients’ common assessments to reduce the chances of 

inaccurate/misplaced data. Once you have the final version of your google form in the accurate 

order and all edits are finalized, please double check one last time to make sure the sequencing 

is accurately reflected in your form response spreadsheet. 

 
C. Delinking Your Responses Spreadsheet 

 

1. Click “Responses (0)” in the top toolbar, then click “Unlink form”. 

 
2. The following window will pop open. Please go ahead and click “Unlink” 

 
3. Go to your responses spreadsheet (which is now unlinked) > click “File” > then click 

“Move to trash”. The following window will open > click “Go to Sheets home screen”. 
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4. Repeat Steps 5.A. Choosing a form response destination, to recreate a responses 

spreadsheet. 

 
Important note: Once you start using your google form for ACTUAL submissions and client 

data, you do NOT want to unlink your form. 

 
Step 6: Filling out sample assessments 

 
BEFORE your google form is used for data entry of actual clients’ common assessments, we 

highly recommend that you fill out sample assessments (not actual client surveys but fake 

responses) to get a feel for the google form and to also check for data validity: 

 
I. Fill out sample assessments and submit them in the LIVE version of your google form. 

a. You can access the LIVE version of your form by clicking ‘view live form’ under 

the top toolbar. 

 

II. Double check the accuracy of responses of the sample assessments in your responses 

spreadsheet. 

III. Then delete8 the responses of the sample assessments in your google form. You can 

delete the sample assessments by clicking the “Responses” menu and then selecting 

“Delete all responses”. You will also want to check your form response spreadsheet and 

delete the rows that have sample assessments as well. 

 
Important Note: Once you start using your google form for data entry of actual clients’ common 

assessments, please keep in mind, you do NOT want to delete any responses. If there is an 

accidental submission or duplicate submission, you may delete the row in your responses 

spreadsheet, but otherwise, you do NOT want to “delete all responses”. 

 
 
 
 

8      https://support.google.com/docs/answer/2923993?hl=en&ref_topic=6063584 

https://support.google.com/docs/answer/2923993?hl=en&amp;ref_topic=6063584
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Step 7: Data Entry 

 
Data entry persons will be using the LIVE version of your google form and multiple data entry 

persons may use the LIVE version URL link of the google form simultaneously. Data Entry 

persons will NOT need access to the EDIT version of the google form. The Share your form with 

collaborators link goes over how you can add additional collaborators for the edit version of your 

form, however, we suggest that you limit the number of collaborators to curb the chances of 

accidental edits being made after the form is being used for data entry of actual common 

assessments. 

 
In Step 3: Confirmation Page, if you’ve decided to check off “Allow responders to edit responses 

after submitting”, (responders meaning your data entry persons), they will have the ability to edit 

the responses of submitted forms. This may be useful in case there are any errors in the 

submitted responses. 

 
When a data entry person submits a client’s VI-SPDAT using the Sample Community VI-SPDAT 

(CA V.2.0.) - 5/27/16 google form, s/he will see this submission page: 

 

 
At the bottom of this submission page, the data entry person has the option to click “edit your 

response” or “submit another response”. The data entry person may click the URL link for 

“edit your response” to edit or may save the URL in the case s/he needs to come back to that 

specific VI-SPDAT. Please keep in mind that if you decide to allow responders to edit responses 

after submitting, that they are careful with the URL link of the “edit your response” page, as it will 

allow others with that link URL to also edit that submission. 

https://support.google.com/docs/answer/2917111?hl=en&amp;ref_topic=6063584
https://support.google.com/docs/answer/2917111?hl=en&amp;ref_topic=6063584
https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
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PART IV: The Data Set, Analysis, & Creating Dashboards 

 
You have created/accessed the following Docs Editors thus far: 

1. Your Google Form: EDIT version 

2. Your Google Form: LIVE version 

3. Your Form Response Spreadsheet 

 
The 4th Docs Editor to create will be another spreadsheet - for the purposes of this guide, 

we’ll call this the “Data MGMT” spreadsheet. This is where you may have the following 

components: 

● Component A: The Code Book 

● Component B: The Tidy Data Set + Formulas 

● Component C: Dashboards 

● Additional optional analyses/dashboards 

 
You can decide to create a separate google sheet for each of the components above, however, 

we recommend consolidating these components in one spreadsheet under different tabs of the 

spreadsheet to keep things simpler. 

 
You also have the option to embed these components in your 3rd Doc Editor: the form response 

spreadsheet, however, we recommend that formulas/dashboards be housed in separate 

spreadsheet(s) in case there are any accidental unlinking of the form response spreadsheet to 

your google form. 

 
If you would like to review the basics of how to use Google Sheets, before jumping into creating 

your 4th Docs Editor, you can find instructions on how to get started on google sheets in 

APPENDIX II: GET STARTED ON GOOGLE SHEETS (Introductory). 

 
Component A: The Code Book 

 
A “code book”, is a type of reference place that can list out your form questions, response 

options for each question, scoring prompts (if they are included your common assessment), 

domain names, etc. Additionally, this can be where you can house copies of formulas for any 

scoring prompts and spreadsheet column header letters associated with your data. The 

formulas and column header letters can be filled in after you create component B. 

 
After you create your Data MGMT spreadsheet, rename the first tab for your Code Book. You 

can rename the tab by double clicking on the name of the tab. For the Sample Community 

VI- SPDAT (CA V.2.0.) - 5/27/16 form and responses, this is the corresponding data mgmt 

spreadsheet: DATA MGMT: SAMPLE Cmty name - VI-SPDAT (CA V.2.0.) - 5/27/16. In the first 

tab titled ‘Code Book’ - you can see a sample of how the code book is set up for this 

community’s form responses. 

https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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Component B: The Tidy Data Set + Formulas 

 
This component refers to a copied and pasted raw data set from your form response 

spreadsheet, which you will then clean up. This cleaned-up version of the raw data will be 

referred to as the “tidy data set”. This can also include columns that house formulas for any type 

of scoring (such as the VI-SPDAT score calculation) or other calculations needed for line-by-line 

data. The steps below outline how to create this component: 

 
1. First, create a new tab in your data mgmt spreadsheet. You can do this by clicking the 

“+” button at the bottom left hand corner of your new spreadsheet. For the DATA MGMT: 

SAMPLE Cmty name  - VI-SPDAT (CA V.2.0.) - 5/27/16 sheet, this new tab is titled 

‘Form Responses 1’. 

 
2. Open up your form response spreadsheet that is linked to your google form and copy 

your entire raw data. Paste it on to the new tab of your data mgmt spreadsheet. The 

‘Form Responses 1’ tab in the DATA MGMT: SAMPLE Cmty name - VI-SPDAT (CA 

V.2.0.) - 5/27/16 link, has pre-copied and pasted sample raw data. 

a. After pasting, you may choose to add an additional row before the first pasted 

row at the very top, to differentiate the various sections/domains of your common 

assessment/google form. In the sample data mgmt sheet, this has already been 

created, and color fills have been added to differentiate the domain sections. 

b. If you would like to include formulas for scoring or calculating line by line 

data, you can choose to create the formulas before copying/pasting the raw data. 

To do this, copy just the first row that holds the questions as headers, and paste 

them into your newly created component B tab. You can skip down to the next 

page to Formulas for your tidy data set and revisit pasting and tidying your raw 

data after you create your formulas. . 

c. Shortcut for highlighting: Near the top left, where the column titles (A, B, C, 

D….) meets the row titles (1, 2, 3, 4….), click on the box where A and 1 meet 

(this is the small box right below fx). Once you click this box, the entire 

spreadsheet should be highlighted. Please copy. 

 
3. After pasting your raw data, you will want to ensure that all responses are correctly 

submitted. For example, the first question, “How long has it been since you lived in 

permanent stable housing? (in months)”, require a numerical value response or the text 

response of refused”. You will want to double check that column to ensure that all 

responses are standard and that no one has submitted an assessment with a response 

outside of the perimeters of the response options you are looking for. To easily check 

your raw data, you may use filtering (see Appendix II, 7) Filter your Data) or 

conditional formatting (see Appendix III, A. HOW TO USE CONDITIONAL 

FORMATTING). 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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4. Additionally, if your finalized google form has questions that include the “other” option in 

the responses for the ‘multiple choice’ and the ‘checkboxes’ question types, and you 

have made those questions required, you can also clean up those corresponding 

question columns in your Tidy Data Set tab. 

a. For example, in the DATA MGMT: SAMPLE Cmty name  - VI-SPDAT (CA V.2.0.) 

- 5/27/16 form, question 1, “where do you sleep most frequently?” has response 

options: shelters, couch surfing, outdoors, refused, & other:  . Since this 

question was created as a required question, you can double check in the 

column with the responses in your Tidy Data Set tab, to see if there are any 

empty cells for submitted assessments. If there are, the community can decide to 

manually insert the text ‘other: not specified’ in those empty cells. To find these 

cells, the community may use filtering (see Appendix II, 7) Filter your Data) or 

conditional formatting (see Appendix III, A. HOW TO USE CONDITIONAL 

FORMATTING). 

 
Formulas for your tidy data set 

 

Your Tidy Data Set tab may also house columns that include formulas for any type of scoring 

(such as the VI-SPDAT score calculation) or other line-by-line calculations needed (e.g. 

converting MM/DD/YYYY dates into a number of years). APPENDIX III: WORKING WITH 

FORMULAS + SCRIPTING goes over introductory google spreadsheet formulas. You can also 

find additional formulas and explanations of each on the Google spreadsheets function list 

website. 

 
Important Note: If you decide to insert formulas, before you do so, we suggest that you insert a 

few columns (approximately 10-15 columns) after the column that has your final common 

assessment question (column BM in the sample data mgmt sheet) and leave them empty. Then 

insert a sufficient number of columns to house your formulas (24 columns in the sample sheet, 

which are columns CF:DC). The empty 10-15 columns between the final common assessment 

question and the first formula column may come in handy in the case that you decide to add 

additional line-by-line information. 

 
Using Advanced IF Formulas with ARRAYFORMULA for Scoring Calulations 

 
This section will go over some more advanced uses of IF formulas & ARRAYFORMULA 

simultaneously. The grey sections below review the formula, syntax, and general notes. The 

white sections below each grey portion show examples of these formulas within the DATA 

MGMT: SAMPLE Cmty name - VI-SPDAT (CA V.2.0.) - 5/27/16 spreadsheet. The example 

formulas are inserted in the third row, far right columns of the ‘Form Responses 1’ tab. You can 

click through cells CF3:DC3 and see the formulas in the formula ( fx ) bar. 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://support.google.com/docs/table/25273?hl=en
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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IF Formula 

Returns one value if a logical expression is ‘TRUE’ and another is ‘FALSE’. 

 
Syntax:  =ArrayFormula(IF(logical_expression,  value_if_true, value_if_false)) 

 
Note: You may also choose NOT to have a value_if_false. If you decide not to use value_if_false, then 

the cell will automatically insert the text “FALSE” if the logical expression is not true. 

Example: Syntax breakdown: 

Question 7 (Column Z) logical_expression: $Z$3:$Z="yes" 

Response options: Yes, No, Refused value_if_true: 1 

value_if_false: 0 

VI-SPDAT scoring prompt for question 7: 

“if ‘Yes’, then score 1 for  legal issues” Formula (Column CK): 

=ArrayFormula(IF($Z$3:$Z="yes", 1,0) 

IF/”OR” Formula 

In order to set up scoring for IF/OR formulas, because the OR formula yields a single result, for an array 

formula, we will need to nest multiple IF functions. 

 
Syntax (where N is the number of logical expressions needed): 

ArrayFormula(IF(logical_expression1, value_if_true, IF(logical_expression2, value_if_true, 

IF(logical_expression3,  value_if_true,  ….IF(logical_expressionN,  value_if_true,  value_if_false)))))… 

E   x   a   m   p  l  e #1 

 
Question 8 (Column AA) Syntax breakdown: 

Question 9 (Column AB) logical_expression1:  $AA$3:$AA="yes" 

Response options: Yes, No, Refused logical_expression2:  $AB$3:$AB="yes" 

value_if_true: 1 

VI-SPDAT scoring prompt for questions 8 value_if_false: 0 

& 9: 

“if ‘yes’ to any of the above, then score  1 for Formula (Column CL): 

risk of exploitation” =ArrayFormula(IF($AA$3:$AA="yes",  1, 

if($AB$3:$AB="yes", 1, 0))) 

E   x   a   m   p  l  e #2 

 
Question 10 (Column AC) Syntax breakdown: 

Question 11 (Column AD) logical_expression1:  $AD$3:$AD  = "no", 

Response options: Yes, No, Refused logical_expression2:  $AC$3:$AC  = "yes" 

value_if_true: 1 

VI-SPDAT scoring prompt for questions value_if_false: 0 

10 & 11: 

“if ‘yes’ to question 10 or ‘no’ to  question 11, Formula (Column CM): 

then score 1 for money management” =ARRAYFORMULA(if($AD$3:$AD  = "no",1, 

if($AC$3:$AC = "yes",1,0))) 
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IF/”AND” Formula: 

In order to set up scoring for IF/AND formulas, because the AND formula yields a single result, for an 

array formula, we will need to nest multiple IF functions. 

 
Syntax (where N is the number of logical expressions needed): 

ArrayFormula(IF(logical_expression1,   IF(logical_expression2,  IF(logical_expression3, 

….IF(logical_expressionN, value_if_true, value_if_false), value_if_false), value_if_false), 

value_if_false))… 

 
Note: The syntax is similar to the IF/OR formula, however, for IF/ANDs, we will NOT include the 

value_if_true until the nth logical_expressionN portion of the formula. 

Example:        

Question 1 (Column O) 

Response options: Shelters, Couch Surfing, 

Outdoors, Other (specify):  , Refused 

 
VI-SPDAT scoring prompt for question 1: 

“if the person answers anything other than 

‘shelter’ and ‘refused’, then score  1” 

Syntax breakdown: 

logical_expression1: $O$3:$O<>"shelters" 

logical_expression2: $O$3:$O <>"refused" 

logical_expression3: $O$3:$O <>"" 

value_if_true: 1 

value_if_false: 0 

 
Formula (Column CG): 

=ARRAYFORMULA(IF($O$3:$O<>"shelters", 

IF($O$3:$O <>"refused", IF($O$3:$O <>"", 1,0),0), 0)) 

 
Note: The formula includes 

logical_expression3:  $O$3:$O <>"" 

Because without that logical expression, it will consider 

all cells including empty ones. Additionally, the “other” 

option (through the google form) may produce empty 

cells if other is not specified. Please refer to (PAGE 

234982) in the Tidy data set section regarding tidying up 

empty cells. 
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Examples of Using Advanced Combination Formulas 

 

E   x   a   m   p  l  e #1 

Source: DATA MGMT: SAMPLE Cmty name - VI-SPDAT 

(CA V.2.0.) - 5/27/16 

 
Question 2 (Column P) 

Question 3 (Column Q) 

 
Response options: numerical value,  “refused” 

 
VI-SPDAT scoring prompt for questions 2&3: 

“if the person has experienced 6 or more consecutive months 

of homelessness, and/or 3+ episodes of homelessness, then 

score 1” 

Formula (Column CH): 

=ArrayFormula(IF((IF($P$3:$P>=6, 

IF($P$3:$P<=5000000, 1, 

0)))+(IF($Q$3:$Q>=3, 

IF($Q$3:$Q<=5000000, 1, 0)))>=1, 1,0)) 

Note: This one is a bit tricky. Because the response options allow for both a numerical value or the text 

“refused”, and the scoring is dependant on the numerical responses of two different columns, the formula 

for each column will have to include a numerical limit to exclude rows that have “refused” in the cell. 

 
So let’s separate the scoring prompt by looking at the first part of the scoring prompt. In column P, we 

want responses that are >=6 and we want to add a <=# (large enough number that will include large 

range of all possible numerical response values) expression in there as well such that we would be using 

a IF/”AND” formula. Thus, we have: 

 
Part 1: IF($P$3:$P>=6, IF($P$3:$P<=5000000, 1, 0)) 

 
Now we have the second part of the scoring prompt. In column Q, we want responses that are >=3 and 

<=#. So we have: 

 
Part 2: IF($Q$3:$Q>=3, IF($Q$3:$Q<=5000000, 1, 0)) 

 
We’ve used the IF/”AND” formulas to account for the numerical values in the cells of EACH column, 

however the scoring prompt is IF/”OR” for BOTH columns. We can’t use a combination of if/”AND” 

formulas and if/”OR” formulas in this case, thus, decided to use the “+” addition symbol as a workaround 

to get at the IF/”OR” aspect. The addition of part 1 and part 2 could yield a few different responses. It 

could equal 0, 1, or 2. We want those with >=1 to have the ultimate scoring value of 1 to fulfil the scoring 

prompt. Thus we have: =IF((Part 1)+(Part 2)>=1, 1, 0) 

 
When we turn this into the actual formula, it becomes: 

 
=ArrayFormula(IF((IF($P$3:$P>=6,  IF($P$3:$P<=5000000,  1, 0))) 

+(IF($Q$3:$Q>=3, IF($Q$3:$Q<=5000000, 1, 0)))>=1, 1,0)) 

E   x   a   m   p  l  e #2 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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Source: DATA MGMT: SAMPLE Cmty name - VI-SPDAT 

(CA V.2.0.) - 5/27/16 

 
Question 4.a. (Column R) 

Question 4.b. (Column S) 

Question 4.c. (Column T) 

Question 4.d. (Column U) 

Question 4.e. (Column V) 

Question 4.f. (Column W) 

 
Response options: numerical value,  “refused” 

 
VI-SPDAT scoring prompt for question : 

“If the total number of interactions equals 4 or more, then 

score 1” 

Formula (Column CI): 

=arrayformula(if(if($R$3:$R<>"refused", 

$R$3:$R, 0) 

+if($S$3:$S<>"refused", $S$3:$S, 0) 

+if($T$3:$T<>"refused", $T$3:$T, 0) 

+if($U$3:$U<>"refused",  $U$3:$U, 0) 

+if($V$3:$V<>"refused", $V$3:$V, 0) 

+if($W$3:$W<>"refused", $W$3:$W, 

0)>=4, 1, 0)) 

Other helpful formulas (links include additional details on the formulas) 

 

E   x   a   m   p   l   e #3 (using combination of ARRAYFORMULA, IF, + other formulas) 

Source: Other common assessment (not from the   VI-SPDAT) 

 
Question: Over the past year, how much of the time have you 

been homeless? [Best estimate - please type the # followed by 

either DAYS / WEEKS / MONTHS.] 

 
Because response options in one column, can have a variety 

of texts, the formula to the right converts days, weeks, months 

responses to a month(s) value. 

=arrayformula(if(isnumber(SEARCH("m 

onth", $A$3:$A)), LEFT($A$3:$A, 

SEARCH(" ", $A$3:$A, 1))/1, 

if(isnumber(SEARCH("week", 

$A$3:$A)), LEFT($A$3:$A, SEARCH(" 

", $A$3:$A, 1))/4.286, 

if(isnumber(SEARCH("day", $A$3:$A)), 

LEFT($A$3:$A, SEARCH(" ", $A$3:$A, 

1))/30, if((isnumber($A$3:$A)), "didnt 

specify, check",0))))) 
 

REPT Returns specified text repeated a number of times. 

ISNUMBER Checks whether a value is a number. 

SEARCH Returns the position at which a string is first found within text, ignoring case. 

LEN Returns the length of a string. 

TRIM Removes leading and trailing spaces in a specified string. 

RIGHT Returns a substring from the end of a specified string. 

LEFT Returns a substring from the beginning of a specified string. 

SUBSTITUTE Replaces existing text with new text in a string. 

 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://support.google.com/docs/answer/3094134?hl=en&amp;ref_topic=3105625
https://support.google.com/docs/answer/3093296?hl=en
https://support.google.com/docs/answer/3094154?hl=en
https://support.google.com/docs/answer/3094081?hl=en
https://support.google.com/docs/answer/3094140?hl=en
https://support.google.com/docs/answer/3094087?hl=en
https://support.google.com/docs/answer/3094079?hl=en
https://support.google.com/docs/answer/3094215?hl=en
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Spot Checking Formulas + Tips for Troubleshooting Formulas9
 

 

For any formula you are creating, you will want to spot check each of them. Below are different 

tips on how you can double check for accuracy and additional tips for troubleshooting. 

 
It’s important to test out all formulas. If you’re creating a formula with a limited number of 

response combinations, then it may help to test out each combination of potential responses as 

a way to test out the formula. 

 

 
 

9        http://www.techrepublic.com/blog/10-things/10-tips-for-troubleshooting-excel-formulas-and-functions/ 

Let’s take a look at Example #1 from Using Advanced Combination Formulas. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

=ArrayFormula(IF((IF($P$3:$P>=6, IF($P$3:$P<=5000000, 1, 0)))+(IF($Q$3:$Q>=3, 

 

 
 

http://www.techrepublic.com/blog/10-things/10-tips-for-troubleshooting-excel-formulas-and-functions/
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The easiest way to see that a formula is not working, is if you see an error value10 in the cell. At 

times, some error values are ok (e.g. you set a division formula and the denominator is zero 

because the actual value is 0). Understanding the following error values may help with 

correcting your formula: 

 
1. #DIV/0: You can't divide by 0 and your formula refers to a cell that contains or evaluates 

to 0 or is blank. 

2. #NAME?: This error occurs when you refer to a range incorrectly or forget to enclose 

text in quotation marks. When Google Sheets encounters text in a formula, it tries to 

interpret the text as a cell reference, a range name, or a function name. When it can't 

recognize the text as any of those things, it displays this error value. Check your function 

names, cell references, and range names (make sure the range name actually exists if 

you've spelled it correctly). If all ranges are correct, make sure you've delimited text 

using quotation marks. 

3. #NULL!: You specified an intersection between two ranges that don't intersect, such as 

A1:C3 and D4:F6. If the ranges do intersect, you've probably used a space character 

instead of a comma to separate the two ranges (A1:C3 D4:F6 instead of A1:C3,D4:F6). 

4. #NUM!: This error value indicates a problem with a number in the formula. Either the 

argument is invalid or the result is too large or small. 

5. #REF!: You've referenced a cell incorrectly. Most likely, you've deleted a cell. For 

instance, the expression =A1+B1 won't return an error if you delete the value in B1. But 

if you delete column B, it will. 

6. #VALUE!: You've expressed the wrong data type or operator. The most common cause 

for this error value is a reference to text by a numeric operation. 

7. #N/A: The #N/A error value isn't like the rest — there's usually nothing wrong with the 

formula itself. It means that spreadsheet can't return a result that makes sense or can't 

find the value you're looking for or that you haven't sorted the list (which isn't always 

necessary). To fix this, you can wrap the original function in an error-handling routine 

that displays a meaningful message or more appropriate value. For instance, you might 

display the message, "value not found" — the user understands that — whereas the 

#N/A value might cause confusion. 

 
At times, your spreadsheet will not always tell you if a formula is wrong. It will usually just go 

ahead and run the calculations and give you the wrong answer. It's up to you to double-check 

your formulas whenever you create them. These tips won't help you solve every problem you 

encounter, but they should provide you with the tools to identify many common errors. 

 
● Check the references. Most formulas use at least one cell reference. When you 

double-click a formula, it will highlight all of the referenced cells. You can then 

double-check each one to make sure they are correct. 

 

 
10      http://ccm.net/faq/28880-spreadsheet-error-messages-related-to-the-formulas 

http://ccm.net/faq/28880-spreadsheet-error-messages-related-to-the-formulas
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● Look for mix-ups. A common mistake is to use the correct cell references, but in the 

wrong order. For example, if you want to subtract C2 from C3, the formula should be 

=C3-C2, not =C2-C3. 

● Break it up. If a formula is too complicated to check, try breaking it up into several 

smaller formulas. This way, you can check each formula for accuracy, and if there are 

any problems you will know exactly where they are. 

● Ballpark it. Generally, you’ll be able to tell what the answer should be. If the formula 

gives you a much larger or smaller value than expected, there may be a problem with 

your formula (or with the values in the cells). 

● Order of operations. All spreadsheets calculate formulas based on the order of 

operations. Your spreadsheet will always use this ordering, which means it doesn't just 

calculate a formula from left to right. Particularly with advanced complex formulas, 

double check to make sure this is accurate. 

 
Saving Formulas into Your Code Book 

 

We highly recommend that any formulas that you create for your tidy data set are copied and 

pasted into your code book tab as a reference. When you copy the actual formula, make sure to 

highlight the formula WITHOUT highlighting the “=” symbol. 

 
As mentioned in Component A: The Code Book, it can be helpful to also list out your column 

header letters for corresponding questions, scoring prompt formulas, corresponding columns for 

scoring prompts, domain formulas (if any), corresponding columns for domain formulas, etc. 

 
If any formulas are adjusted/edited, make sure to update your code book! 

 
Important Note: If you delete, move, or add any columns/rows AFTER formulas have been 

inserted in separate cells, please make sure to double check your formulas 

 
Component C: Dashboards 

 
Dashboards: A dashboard is a tool for visualizing and communicating important data points 

 
Generally, your dashboards may reflect your targets (interim objectives that are monthly, 

quarterly, etc. that help determine if you are on track to meet your goal). For example you may 

create dashboards that tracks the number of clients who are housed each month and the rate in 

which clients are being housed. 

 
You may also create dashboards that are descriptive of a data set, such as the clients that are 

assessed during a registry week. 

 
For this section, we’ll review general use of tables, charts, formulas, and 

visualization/formatting, using the example provided in the ‘Dashboards’ tab in the DATA 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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MGMT: SAMPLE Cmty name - VI-SPDAT (CA V.2.0.) - 5/27/16 spreadsheet, which are 

descriptive of the sample community’s common assessment responses. 

 
Remember - to create quality dashboards: 

● Know your audience 

● Update your data in real time 

● Only include what you really need 

● Value function over form 

 
Step 1: Selecting Data Points for Your Dashboards 

 

Before creating aggregate dashboards, it may be helpful to separately outline the kinds of 

dashboards you may need/want to see. The following data analysis questions, which were also 

in Part II, G. Data Analysis Questions, may help you with outlining your dashboards: 

● What pieces of data gathered from your common assessment need to be analyzed? 

● What pieces of data need to be aggregated for analysis? Filters for specific groups (e.g. 

special populations such as veterans)? 

● What type(s) of analysis is/are needed? (e.g. descriptive, exploratory, inferential, 

predictive, etc.) 

● What is/are the purpose(s) for data analysis? 

● Will the analysis be presented? If so, how will it be presented? Visualized? 

 
Step 2: Formatting Your Dashboards 

 

You’ll now want to create your dashboards based off the outline you created from the previous 

step, and you’ll also want to format them in the way you see fit. 

 
Let’s take a look at the ‘Dashboards’ tab in the DATA MGMT: SAMPLE Cmty name - VI-SPDAT 

(CA V.2.0.) - 5/27/16  spreadsheet. Here are some elements that may be helpful to include 

when creating/formatting your dashboards: 

● Titles for each section (e.g. “demographic & overview”, “VI-SPDAT aggregate domain 

analysis”, “special populations”, etc.) 

○ Titles for each table (e.g. “total interactions”, “VI-SPDAT Individual Dashboard”) 

○ Titles for each chart 

● When the data points were collected (Registry week start date and end date) 

● When the data points were entered (data entry start date end date) 

● Total numbers (total interactions, total surveys submitted, etc.) 

● Definitions where needed (e.g. “chronic homelessness”, “episodic homelessness”) 

● Differentiating each section with section lines/fill colors 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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Step 3: Inserting Formulas into Your Dashboards 

 

After formatting your dashboards, you can go ahead and insert formulas where needed. 

Because you’ll most likely be pulling in data from your tidy data set tab, you’ll want to include the 

tab name in your formula. You can reference another tab sheet in a formula by entering the 

sheet name and an exclamation mark before the cell being copied. 

 
For example: 

=Sheet1!A1 

='Sheet number two'!B4 

 
Note: If a sheet name contains spaces or other non-alphanumeric symbols, you'll need to 

include single quotes around it (as in the second example above). 

 
The following formulas may be helpful for descriptive aggregate statistics on your clients’ 

common assessment responses: 

 

SUM Returns the sum of a series of numbers and/or cells. 

SUMIF Returns a conditional sum across a range. 

SUMIFS Returns the sum of a range depending on multiple criteria. 

AVERAGE Returns the numerical average value in a dataset, ignoring text. 

AVERAGEIF Returns the average of a range depending on criteria. 

AVERAGEIFS Returns the average of a range depending on multiple criteria. 

COUNTIF Returns a conditional count across a range. 

COUNTIFS Returns the count of a range depending on multiple criteria. 

 

Notes on formulas: 

Remember to add a limit if using numbers. For example, in the ‘Dashboards’ tab in the DATA 

MGMT: SAMPLE Cmty name - VI-SPDAT (CA V.2.0.) - 5/27/16 spreadsheet, in order to 

calculate how many respondents are in need of permanent supportive housing (score of 8 or 

above), cell D16 holds the following formula with a numerical limit: 

=COUNTIFS('Form Responses 1'!$DC$4:$DC, ">=8", 'Form Responses 1'!$DC$4:$DC, 

"<=30") 

 
Important Note: Please remember to also spot check formulas, and if needed troubleshoot, 

your dashboard formulas as well. 

https://support.google.com/docs/answer/3093669?hl=en
https://support.google.com/docs/answer/3093583
https://support.google.com/docs/answer/3238496?hl=en
https://support.google.com/docs/answer/3093615?hl=en
https://support.google.com/docs/answer/3256529?hl=en
https://support.google.com/docs/answer/3256534?hl=en
https://support.google.com/docs/answer/3093480
https://support.google.com/docs/answer/3256550
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
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Step 4: Integrating Charts in Your Sheet 
 

How to: Add a chart or graph to your sheet11: 

 

A. Select the cells with data you want to include in your chart. Note: To make labels on your 

chart, add a header row or column to your data. 

B. Click Insert > Chart. 

C. In the "Recommendations" tab, choose a chart style. For more options, click Chart types. 

D. To edit your chart, click Customization. 

E. To create the chart, click Insert. 

 
How to: Edit and format your chart12: 

 

A. Make quick edits: To make small, fast edits to a chart, you can use Quick Edit mode 

with many different chart types. 

a. Click on a chart. 

b. On the right, click Quick edit mode . 

c. Click the part of the chart that you'd like to change: 

i. Chart title: Change the font style, size, or color. 

ii. Horizontal or vertical axis labels: Change the font style, size, or color. 

iii. Legend: Change the font style, size, data series color, or position. 

iv. Data series: Change the color, line thickness, dot size, or axis it belongs 

to. For example, click on a line you want to edit in a line chart or click on a 

bar in a bar chart. 

v. Chart background: Resize your chart, move it within the chart area, 

change the font or background color, or adjust the number of grid lines 

shown. 

vi. Note: A number of these editing features are also available by 

right-clicking on a section of your chart. 

 
B. Make advanced edits: To fully customize your chart, you can use Advanced Edit mode. 

a. In the top right, click the dropdown arrow. 

b. Select Advanced edit. 

c. In the window that appears, select a tab: 

i. Recommendations: Choose from a list of recommended chart types to 

display your data. 

ii. Chart types: See a list of all chart types. 

iii. Customization: Make changes to the axes, series, and appearance for 

your chart. 

 

 

11 https://support.google.com/docs/answer/63728?hl=en&ref_topic=30239 
12 https://support.google.com/docs/answer/63824?hl=en&ref_topic=30239 

https://support.google.com/docs/answer/63728?hl=en&amp;ref_topic=30239
https://support.google.com/docs/answer/63824?hl=en&amp;ref_topic=30239
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C. Switch rows and columns in a chart: To switch the position of the rows and column 

data in your chart: 

a. Click on the chart. 

b. In the top right, click the dropdown arrow. 

c. Select Advanced edit. 

d. In the window that appears, click Chart types. 

e. Check the box next to "Switch rows/columns" to switch the order of the data. 

 
D. Include hidden or filtered data in a chart: To include data in your chart that has been 

hidden or filtered in a spreadsheet: 

a. Open a spreadsheet and click on the chart. 

b. In the top right, click the dropdown arrow. 

c. Select Advanced edit. 

d. In the window that appears, select the Chart types tab. 

e. Check the box next to "Include hidden/filtered data." 

f. To remove this data from the chart, uncheck the box again. 

 
How to: Create Different Chart types13

 

 
A. SCATTER PLOT 

A scatter chart displays numeric coordinates along the X- and Y-axis. The data in your 

spreadsheet is displayed as a series of points on a graph. Your data should be formatted in two 

or more columns, all of which contain numeric data. The first column of data should contain 

X-values on your chart, while each remaining column should contain Y-values. Each column of 

Y-values will show as a series of points on the chart. 

 

13 https://support.google.com/docs/answer/190718?hl=en 

https://support.google.com/docs/answer/190718?hl=en
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B. BAR CHARTS 

 
Bar charts are a good way to visualize one or more categories of data, particularly if each 

category has sub-categories. These charts allow you to visually express the difference between 

the data points of each category. 

● Data Format: Each row in your spreadsheet represents a different bar in the chart. In 

the first column of your spreadsheet, write the labels or classifications for each row. 

Each remaining column needs to contain numeric data. The data format for a bar chart is 

the same as the data format for area and line charts. You may also want to name each 

of the columns containing data in your spreadsheet. If you do so, we’ll automatically 

detect these names and use them as labels for your data on the chart. You can also set 

or change this setting by selecting the checkbox that reads 'Use Row A as headers.' 

Last, you can chart uncertainty about your data using boolean values. 

● Stacked bar chart: Data for a stacked bar chart is structured similarly to a bar chart, but 

data for each label or classification is aggregated into one bar, instead of multiple bars. 

This bar contains all data for any given label or classification, and allows you to see the 

relationship of parts to the whole. 

 
C. PIE CHARTS 
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2D Version 3D Version Donut Version 

 

 

 

 
 

 

 
 

A pie chart (also known as a pie graph) allows you to visualize data as “slices of pie,” or 

proportions of a whole. 

● Data Format: Your data should be contained in two columns of your spreadsheet; the 

first column contains a label, and the second column contains a numeric value 

representing that label. In the Chart types tab of the Charts Editor dialog, you can switch 

between the 2D and 3D versions of the pie chart, or turn a pie chart into a donut chart. 

● Customization options: In addition to the regular customization options available for 

Google Charts, the pie chart allows you to select the labels you’d like to see for each pie 

slice. To do this, click on the Customization tab, scroll down to Slice, and select an 

option: 

○ Percentage shows each slice as a calculated percentage of the total 

○ Value displays the number associated with each slice (from the right-hand 

column in your data table) 

○ Label shows the name of each slice (from the left-hand column in your data 

table) 

○ None allows you to leave the slices blank and rely solely on the color-coded 

legend 

As you select each of these options, you can also change the font size and text color 

associated with the option to the right of the Slice drop-down menu. You can also add 

legend labels to each pie slice instead of keeping your legend to the right or above the 

pie itself. To do this: 

● Open the chart editing dialog. 

● Click the Customize tab. 

● Go to the Legend option and select Labeled. 
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D. ORGANIZATIONAL CHART 

An organizational chart (also called an org chart) shows the structure of a company, group of 

people, or family tree by displaying the relationships between group members. 

● Data format: List all group members in one column of your spreadsheet, and their 

hierarchical or higher-level relationship in the next column. If you want a tooltip to appear 

when you point your mouse to each node, you can enter this text in a third column. 

 
E. TABLE CHART 

A table chart turns your standard spreadsheet table into chart that can easily be sorted and 

paged. When viewing the table, you can select single rows with either the keyboard or the 

mouse, and you can sort individual columns by clicking on column headers. If your table is 

particularly large, the header row remains fixed as you scroll. 

● Data format: Unlike most charts, the data format for a table chart is flexible and 

customizable, with the one restriction that the data within each column must be 

consistent. A column should contain data formatted in the same way -- if you 

mix-and-match data formats within a column, the table won’t render properly. 
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F. MAP CHART 

A Map chart is a map of a country, continent, or region map, with colors designating values 

associated with each of the map's locations. 

● Data format: In the first column, enter location names or region codes. In the second 

column, enter numeric values. These values will modify the color density of each 

location. 

● Creating a Map chart: Let's say you're displaying countries in terms of population, and 

you want to show this information on a map. List the locations in the first column, and 

enter the number of people who live there in the next column. To create a map from your 

data set, select Insert > Chart. In the charts dialog, click the Chart types tab, then click 

Map. Select one of the GeoMap options. Navigate to the Customize tab, where you can 

modify the color that appears on your map. For example: 

Min (0): Select White as the corresponding color 

Mid (50): Select a Medium Green color 

Max (100): Select a Deep Moss color 

You can create a Map chart with the values associated with each country designated 

through colors only. Or, you can use a circular marker for each country, designating the 

relative size of the value associated with the country through color and the marker's size. 

Click Insert, and your chart will be inserted into your spreadsheet. 
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G. LINE CHART 

A line chart is a good way to display numeric data graphically, and is particularly useful when 

expressing changes in value between categories of data. 

● Data Format: In the first column, enter a label to describe the data represented in the 

line chart. The remaining columns will each represent a line on the chart and must 

contain numeric data. You can have one or more of these columns to show on the chart. 

The data format for a line chart is the same as the data format for bar, area, and column 

charts. You may also want to name each of the columns containing your data. If you do 

so, we’ll automatically detect these names and use them as labels for your data on the 

chart. You can also set or change this setting by selecting the checkbox that reads 'Use 

Row A as headers.' 

 
H. COLUMN CHARTS 

Column charts are a good way to visualize one or more categories of data, particularly if each 

category has sub-categories. These charts allow you to visually express the difference between 

the data points of each category. In the chart below, for example, we can track Olympic medals 

earned by country, with the sub-categories of Gold, Silver and Bronze medals. 

● Data Format: Each row in your spreadsheet represents a different column in the chart. 

In the first column of your spreadsheet, write the labels or classifications for each row. 
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For example, this could be countries or other classifications of data. Each remaining 

column needs to contain numeric data. The data format for a column chart is the same 

as the data format for bar, line, and area charts. You may also want to name each of the 

columns containing your data. If you do so, we’ll automatically detect these names and 

use them as labels for your data on the chart. You can also set or change this setting by 

selecting the checkbox that reads ‘Use Row A as headers.’ 

● Stacked column chart: Data for a stacked column chart is structured in the same way 

as a standard column chart. In stacked column charts, however, each category has only 

one column. This column contains all data for any given label or classification, and 

allows you to see the relationship of parts to the whole. 

● Histogram: A histogram displays the distribution of a data set. In your spreadsheet's first 

column, put labels for your groups of data. Then, in subsequent columns, place numeric 

values, each representing items in a distribution. Only one column of data is required to 

generate the histogram. For each column, the values from all rows are grouped into 

numeric buckets. The histogram displays the number of values in each bucket, using the 

height of each bar to represent the count of values. 

 
I. AREA CHARTS 

Much like a line chart, an area chart tracks one or more data series graphically, and is 

particularly useful when expressing changes in value between categories of data. 

● Data Format: In the first column, enter a label to describe the data you’re displaying in 

the area chart. For example, you could enter dates or times. The remaining columns will 

each represent an area on the chart and must contain numeric data. You can have one 

or more of these columns to display on the area chart. All data values must be positive in 

an area chart. The data format for a area chart is the same as the data format for bar, 

line, and column charts. You may also want to name each of the columns containing 

your data. If you do so, we’ll automatically detect these names and use them as labels 

for your data on the chart. You can also set or change this setting by selecting the 

checkbox that reads ‘Use Row A as headers.’ 
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J. ANNOTATED TIMELINE 

An annotated timeline is an interactive time series line chart with the option to add annotations. 

You can display one or more lines on the chart. 

● Data format: The first column in your spreadsheet should contain the date (optionally 

including the time of day). The following columns should contain numeric values, titles, 

and annotations. Each numeric column can be followed by one or two optional columns 

containing text. The values in the numeric column are represented in the Y-axis for the 

corresponding time in the first column. The text in the first column following a numeric 

column serves as the titles of your annotations, and the second column with text is the 

annotation content. 

 
K. SPARKLINES 

A sparkline is good for displaying and comparing one or more categories of data, and is often 

used to display data across a time period. It's similar to a line chart, but displays data lines on 

separate axes stacked on top of each other. 

● Data format: Each column of the spreadsheet should contain numeric data, and there's 

no limit to the number of columns that can be displayed in the sparkline. Labeling each 

column in the spreadsheet will allow you to track your data more easily; these labels will 

also appear on the chart. 
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L. COMBO CHART 

A combo chart lets you display each data series as a different marker type, such as column, 

line, or area line. 

● Data Format: The top row of your data set will be the labels for the X-axis of your combo 

chart. The first column will be the labels for each data series (row) in your data set. The 

remaining cells should be filled with the data points you'd like to display on your chart. 

Keep in mind that the top left cell will always be ignored. 

● Creating a combo chart: To create a combo chart from your data set, select Insert > 

Chart. In the charts dialog, click the Chart types tab, then click Line. Select the combo 

chart option. In the Customize tab, choose how you’d like to display each data series. 

Here, you can check the box next to maximize to eliminate whitespace and bring 

additional focus to the data in your chart. Click Insert, and your chart will be inserted into 

your spreadsheet. 

 
M. BUBBLE CHART 

A bubble chart visualizes data with three dimensions. It's similar to a scatter plot where the first 

two dimensions are the x and y coordinates, but it adds a 3rd dimension which is represented in 

the chart as the size of the bubble. Your data should be formatted in five columns. 

● Column 1 - Must be text and will show labels for the series 
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● Column 2 - A number that determines where along the x-axis the bubble appears 

● Column 3 - A number that determines where along the y-axis the bubble appears 

● Column 4 - Should be text and determines the color of the bubble (each word gets a 

different color) 

● Column 5 - A number that determines the size of the bubble (the larger the number, the 

bigger the bubble) 

 
N. MOTION CHART 

A motion chart is a dynamic chart that shows information about several indicators over time. 

Based on the data in your spreadsheet, you'll be able to mix-and-match data categories and 

create a variety of motion graphics within a single chart. 

● Data format: The first column in your spreadsheet should contain the entity names that 

you want to track in the motion chart. The second column needs to include date values, 

either in year, month/day/year, week number or quarter format. All subsequent columns 

can contain either numeric or text data. Text data, for example, could be an indicator of 

the weather for a given day -- "cloudy", "raining", or "clear" -- or the name of the current 

CEO for corporate data.) Columns that display numeric data will be available in the X, Y, 

Color and Size axes of the motion chart, while columns containing text will only appear in 

the drop-down menu for Color. 

 
N. TREE MAP 
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A Tree map is a visual representation of a data tree, organizing objects in a structure of 

parent-child hierarchies. 

● Data format 

○ In the first column, enter the name of an object in your hierarchy. 

○ In the second column, enter the name of the object's parent. Each parent name 

must also appear in the first column. 

○ The third column is the numerical value of the object and controls the size of the 

box. This value must be positive. This column might be empty for entities with 

children entities, since the value for a parent entity is calculated by aggregating 

the values of the children. 

○ The optional fourth column is a numerical value that controls the color of the box. 

The values in the fourth column aren’t aggregated and they can be negative. 

● Creating a tree map chart: To create a tree map from your data set, select Insert > 

Chart. In the charts dialog, click the Chart types tab, then click the "Tree map" option 

under "Other." Navigate to the Customize tab, where you can modify the color that 

appears on your map and select the number of levels of data that you want to display on 

your chart. Then, click Insert. 

 
O. GAUGES 

Gauges allow you to display numeric values or measurements within a range. Each value 

produces a gauge, allowing you to compare and contrast measurements in a visual way. 

● Data format: List the gauge label in one column, and their respective numeric values in 

the second column. 
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P. CANDLESTICK CHART 

To create a candlestick chart, enter the following values into columns. Each row describes a 

single candlestick marker. 

● Column 0: Enter a label for the X-axis. 

● Column 1: Enter a number specifying the low/minimum value of this marker. This is the 

base of the candle's center line. 

● Column 2: Enter a number specifying the opening or initial value of this marker. This is 

one vertical border of the candle. If this value is less than the value in Column 3, the 

candle will be filled; otherwise, it will be hollow. 

● Column 3: Enter a number specifying the closing/final value of this marker. This is the 

second vertical border of the candle. If this value is less than the column 2 value, the 

candle will be hollow; otherwise ,it will be filled. 

● Column 4: Enter a number specifying the high/maximum value of this marker. This is the 

top of the candle's center line. 

To create a candlestick chart from your data set, select Insert > Chart. In the charts dialog, click 

the Chart types tab, then click Trend. Select the candlestick chart, and click Insert. Your chart 

will be inserted into your spreadsheet. 
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Q. RADAR CHART 

A radar chart is a good way to display one or more variables in a two-dimensional graph, with 

one spoke for each variable. A line connects all of the data points from your spreadsheet along 

each spoke. 

● Data Format: You can set up your data in one or more columns. In the optional first 

column, you can enter qualitative data that will replace the ‘degree’ labels along the 

outer circle. All of the other columns should contain numeric data that will serve as the 

data points along each spoke of the radar chart. 
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PART V: Presenting Your Data 

 
Anyone can view a Google Docs, Sheets, or Slides file that you publish14 to the web. When a file 

is published, a copy of the original file is made. The copy is the file that people see when they 

visit your website. It doesn’t carry over sharing permissions, so anyone will be able to see it. 

 
You’ll still have your original file with the same sharing permissions. Only people with view, edit, 

or comment permissions will be able to view, edit, or comment on your original file. 

 
If you would like, you can allow and adjust for specific tabs from your spreadsheets to be 

publically available. For example, a community may decide to make the dashboards component 

of their data mgmt spreadsheet to be publically available to share as a webpage with different 

housing agencies in the community. 

 
How to Publish Your Dashboards Component of your Data MGMT Spreadsheet 

 
1. Open up the tab that you would like to share in your spreadsheet. 

2. In the toolbar underneath the title of the google spreadsheet, please click “File” and then 

click “Publish to the web…” and the following window should appear: 

 

3. You can choose to publish the entire spreadsheet or individual tabs. You can also 

choose to share a Link or Embed the sheet into a website. Please keep in mind, 

because you may have client sensitive data in your data mgmt spreadsheet (such as the 

data in your component B: Tidy data set tab), you will want to publish only individual tabs 

in this case. 

a. If you want to share a LINK of the tab you’d like to share, you can choose a 

publishing format (web page, .csv, .tsv, .pdf, .xlsx, .ods). 

 
 
 
 

 

14     https://support.google.com/docs/answer/183965?hl=en 

https://support.google.com/docs/answer/183965?hl=en
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4. Please click the up and down arrows next to the “Entire Document” button. Once you 

click that, a drop down list of the names of tabs in your data mgmt spreadsheet will 

show. Please click the name you’ve set for your Dashboards tab in that drop down list. 

 
5. Please select the publishing format (web page, .csv, .tsv, .pdf, .xlsx, .ods) for your 

‘Dashboards’ tab. And then click the blue “Publish” button. The following window should 

appear: 

 

 
6. You may either copy the hyperlink and share the link with the audience you would like to 

share this with or you may also choose to embed the dashboards. You may embed by 

clicking “Embed” and copying and pasting the code in the code box. 

a. If you would like a preview of what your dashboards will look like, you can copy 

the link into your web browser. 
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7. Underneath the blue “Published” button should be “> Published content & settings”. 

Please click the triangle/arrow icon left of those words. After clicking, the following drop 

down should appear in the window: 

 

 
8. Please make sure the box left of “Automatically republish when changes are made” IS 

CHECKED OFF. This is to ensure that real-time data is shown when sharing. 

 
9. If you are using a business google account, you can choose to have this checked off if 

you would only like to allow those in your business account to have access to the 

published tab. 

 
10. Please click the “Dashboards” (or whichever 

name you’ve assigned for your dashboards tab) 

button. Once you click that, a drop down list of 

the names of tabs in your data mgmt 

spreadsheet will show once again with a check 

mark left of the name of your dashboards tab as 

well as to the left of your charts. If there are 

empty rows that are checked off, these are 

charts in your dashboards tab without a title. 

Please make sure that the OTHER tabs are 

NOT checked off. 

 
Important Note: If you ever receive a request for 

access to your dashboard spreadsheet from an 

unknown user or from someone you would not like to 

grant access to, please DO NOT GRANT ACCESS 

and DECLINE the request. 
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PART VI: Additional Sample Expansions to Your Data 

 
Let’s review the Docs Editors we have created/accessed so far: 

1. Your Google Form: EDIT version 

2. Your Google Form: LIVE version 

3. Your Form Response Spreadsheet 

4. Your Data MGMT Spreadsheet - with your (a) code book, (b) your tidy data set and 

formulas, (c) dashboards, (d)* any additional analyses 

 
Once you’ve completed assessing people in your community who are experiencing 

homelessness, you may want to use this initial list as the starting point for you By-Name List. 

This section will go over: (a) how you may use some formulas and create additional 

spreadsheets to track placement of clients via the macro level, agency level, and case 

management level of tracking clients, (b) how you may maintain your BNL using a case mgmt 

spreadsheet. 

 
Sample Case Management Google Sheet 

 
This created Case MGMT Sample: Sample Cmty - 5/27/16 sheet that will be referenced 

throughout this section of the guide. 

 
This sample Case MGMT sheet includes the following tabs: 

● Sheet 1: a direct import of Form Responses 1 tab in the DATA MGMT: SAMPLE Cmty 

name  - VI-SPDAT (CA V.2.0.) - 5/27/16 sheet 

● Directory: list of all case managers, affiliate agencies, and contact information 

● Macro level: macro level view of the different agencies, list of case managers at each 

agency, and list of clients for each case manager (vis-a-vis drop down menus) 

● SA - CM A: filtered list of Case Manager A’s clients + columns for additional client notes 

● CM A alt view: an alternate view of Case Manager A’s clients vis-a-vis drop down menu 

● SA - CM D & SA - CM G: both tabs are similar to SA - CM A, except for two other case 

managers. 

● Agency Level - SA: agency level view (specifically the ‘Stark Agency’) of affiliated case 

managers, and a drop down of clients for each case manager, as well as clients’ housing 

process status 

 
Important Note: If you would like to use a similar setup, please make sure that the right data 

sharing agreements are in place. 

https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324


15     https://support.google.com/docs/answer/3093340?hl=en 
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‘Sheet1’ Tab 

 

Sheet 1 uses the IMPORTRANGE function to import the Form Responses 1 (tidy data set) tab 

to this spreadsheet. 

 
IMPORTRANGE Function 

The IMPORTRANGE function15 imports a range of cells from a specified spreadsheet. 

 

Syntax:  =IMPORTRANGE(spreadsheet_key,  range_string) 

● spreadsheet_key - The URL of the spreadsheet from where data will be imported. 

○ The value for spreadsheet_key must either be enclosed in quotation marks or be a 

reference to a cell containing the appropriate text. 

● range_string - A string, of the format "[sheet_name!]range" (e.g. "Sheet1!A2:B6" or "A2:B6") 

specifying the range to import. 

○ The sheet_name component of range_string is optional; by default IMPORTRANGE will 

import from the given range of the first sheet. 

○ The value for range_string must either be enclosed in quotation marks or be a reference 

to a cell containing the appropriate text. 

 
Note: Spreadsheets must be explicitly granted permission to pull data from other spreadsheets using 

IMPORTRANGE. The first time the destination sheet pulls data from a new source sheet, the user will be 

prompted to grant permission. Once access is granted, any editor on the destination spreadsheet can use 

IMPORTRANGE to pull from any part of the source spreadsheet. The access remains in effect until the 

user who granted access is removed from the source. 

 

Sheet1 tab in Cas MGMT Sample: 

Cell A1: 

importrange("https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48K 

Cc-kbU/edit?usp=sharing",  "'Form  Responses 1'!a2:dc2") 

 
Note: this formula excludes the first row from the ‘Form Responses 1’   tab. 

 
Cell A2: 

importrange("https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48K 

Cc-kbU/edit?usp=sharing",  "'Form  Responses 1'!a4:dc1000") 

 
Note: We inserted two importrange formulas because we wanted to remove the third row from the ‘Form 

Responses 1’ tab in the Data MGMT spreadsheet that includes formulas. 

https://support.google.com/docs/answer/3093340?hl=en


16     https://support.google.com/docs/answer/3093318?hl=en 
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If you scroll to column DF:DK, we’ve inserted columns for the following: case manager’s agency, 

agency address, agency phone number, name of case manager (CM for short), CM’s phone 

number, CM’s email address. The sample case mgmt sheet allows for manual inputting of the 

names of clients’ case managers in column DI. Once the case manager’s name is inputted in 

the cell, using a VLOOKUP formula connected to the Directory tab, the other columns (DF, DG, 

DH, DJ, DK) are automatically filled in. 

 

VLOOKUP Function16
 

Vertical lookup. Searches down the first column of a range for a key and returns the value of a specified 

cell in the row found. 

 
Syntax: =VLOOKUP(search_key,  range,  index, [is_sorted]) 

● search_key - The value to search for. For example, 42, "Cats", or I24. 

● range - The range to consider for the search. The first column in the range is searched for the key 

specified in search_key. 

● index - The column index of the value to be returned, where the first column in range is numbered 

1. 

○ If index is not between 1 and the number of columns in range, #VALUE! is returned. 

● is_sorted - [OPTIONAL - TRUE by default] - Indicates whether the column to be searched (the 

first column of the specified range) is sorted. 

 
Note: 

● When searching for numeric or date values, make sure that the first column in the range is not 

sorted by text values. For example, correctly sorted numbers should appear as (1, 2, 10, 100) 

rather than (1, 10, 100, 2) as they would be if they were sorted as strings. Using an incorrect sort 

type may cause incorrect values to be returned. 

● Search keys based on regular expressions are NOT supported. Use QUERY instead. 

● VLOOKUP has much better performance with sorted ranges and is_sorted set to TRUE. 

Consider sorting the column being searched. 

● You can also find matches using pattern strings that include wildcards. The question mark (?) and 

asterisk (*) are the wildcards for search_key, with the question mark standing in for a single 

character and the asterisk standing in for any series of characters. If you need to match an actual 

question mark or asterisk, add a tilde (~) before the character and add an extra tilde if you're 

looking for something with an actual tilde in it. 

 

Sheet1 tab in Cas MGMT Sample: 

Cell DF2: 

=arrayformula(if($DI$2:$DI<>"",  vlookup($DI$2:$DI,  Directory!$A:$F,  2),"")) 

 
Note: 

We’ve also inserted an IF formula to wrap the VLOOKUP formula, in case the case manager column cell 

is empty. 

https://support.google.com/docs/answer/3093318?hl=en
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In cell DM2 of the Sheet1 tab, we’ve inserted the formula: 

=ARRAYFORMULA($I2:I&", "&$G2:G&" ("&$M2:M&")"&" [VI-SPDAT="&$DC2:DC&"]") 

 
This consolidates columns I (last name), G (first name), M (social insurance number), and DC 

(vi-spdat score) into one cell. This will come in handy when aligning specific information to each 

client. You will want to include any kinds of unique client identifiers (UCI), such as the social 

insurance number, when creating a column such as this, especially as some clients may share 

the same names. 

 
‘Macro level’ Tab 

 

Creating an in-cell dropdown list using ‘Data Validation’ 

 
Cell C2 in the ‘Macro level’ tab has a drop down menu of the three agencies that the case 

managers listed in the ‘Directory’ tab represent. 

 
To create this drop down menu of the three agencies, we use sheet data validation17. There 

are two options for in-cell dropdown lists: 

● “List from a range” - validation against a range 

● “List of items” - custom lists 

 
Follow these steps to create an in-cell dropdown list based on a range of cells or a list: 

 
1. Select the cell or cells in which you'd like to create a dropdown list. 

2. Click Data > Validation. 

3. In the dropdown menu next to "Criteria," select either List from a range or List of 

items. 

 
 

17 https://support.google.com/docs/answer/139705?hl=en 

https://support.google.com/docs/answer/186103 

https://support.google.com/docs/answer/139705?hl=en
https://support.google.com/docs/answer/186103


19     https://support.google.com/docs/answer/3093378?hl=en 
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a. If you selected "List from a range," select a range of cells containing the values 

that will populate the list. If you change the contents of the range you've selected, 

the changes will be reflected in the list contained in the validated cell. 

b. If you selected "From a list," enter a set of custom values, separated by commas. 

For example, you could enter "peaches,plums,apricots,cherries." (Note: Don't 

use spaces after commas.) 

4. By default, the cells you selected will contain an arrow button which, when clicked, will 

display the dropdown list. If you don't want the cells to display the arrow button, uncheck 

the checkbox that says "Display in-cell button to show list.” 

5. Click Save. The cells you chose to validate will now display a dropdown list with 

permitted values whenever a user edits the cell. 

 
By default, people are allowed to enter data in a cell that doesn’t match one of the items on the 

list. If they do, they’ll see a warning. If you want to be more strict and allow people only to enter 

information from the list, choose "Reject input" next to the "On invalid data" option. 

 
The INDEX & MATCH function 

 
In cell C5 and cell C8, we use a combination of the INDEX and MATCH function. This is similar 

to the VLOOKUP function, however, with the VLOOKUP function, it’s difficult to return a value 

that is in a column left of the lookup column. 

 

 

18     https://support.google.com/docs/answer/3098242?hl=en 

INDEX & MATCH Combo 

 

 

 
Syntax: =INDEX(reference,   MATCH(search_key,  range, search_type)) 

 

 

 

 

 

 

 

 

Macro Level tab in Case MGMT Sample: 

Cell C5 

=INDEX(Directory!D:D,  MATCH(C2,  Directory!B:B,0)) 

https://support.google.com/docs/answer/3093378?hl=en
https://support.google.com/docs/answer/3098242?hl=en


20     https://support.google.com/docs/answer/3093197?hl=en 
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In cells C12:C40, we use a combination of INDEX, MATCH, FILTER, and COUNTIF formulas. 

This combination formula extracts a list of all the unique values from the Sheet1 tab. However, a 

simple FILTER function will provide the same value if filtering from the Directory tab. 

 

FILTER Function20
 

The FILTER function returns a filtered version of the source range, returning only rows or columns which 

meet the specified conditions. 

 
Syntax: FILTER(range, condition1, [condition2,  ...]) 

● range - The data to be filtered. 

● condition1 - A column or row containing true or false values corresponding to the first column or 

row of range, or an array formula evaluating to true or false. 

● condition2 ... - [ OPTIONAL ] - Additional rows or columns containing boolean values TRUE or 

FALSE indicating whether the corresponding row or column in range should pass through 

FILTER. Can also contain array formula expressions which evaluate to such rows or columns. All 

conditions must be of the same type (row or column). Mixing row conditions and column 

conditions is not permitted. 

○ condition arguments must have exactly the same length as range. 

 
Note: 

● FILTER can only be used to filter rows or columns at one time. In order to filter both rows and 

columns, use the return value of one FILTER function as range in another. 

● If FILTER finds no values which satisfy the provided conditions, #N/A will be returned. 

 
Macro Level tab in Case MGMT Sample: 

Cell C12 

=IFERROR(INDEX((filter(Sheet1!$DI:$DI, Sheet1!$DF:$DF = $C$2)), MATCH(0, 

COUNTIF($C$11:C11, (filter(Sheet1!DI:DI, Sheet1!$DF:$DF = $C$2))),0)),"") 

 
OR 

 
=FILTER(Directory!$A:$A, Directory!$B:$B = $C$2) 

 
 

In cells D12:E40, we use VLOOKUP to assign the appropriate case manager phone numbers 

and emails. 

 
In order to create a drop down of the Case Managers in cell I2, again, we use data validation. 

We used data validation against a range of C12:C40 cells which list the case managers based 

off the Agency selected in cell C2: 

 
 
 
 
 
 

https://support.google.com/docs/answer/3093197?hl=en
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If we change the agency drop down, the drop down for the list of case managers will change as 

well. However, if there was already a name of a case manager for a previous agency, you will 

see that once you change the agency in c2, the case manager dropdown in I2 will flag a ‘Invalid 

content’ warning when you hover your mouse over cell I2: 

 

To resolve this, just click on cell I2 and you will see the appropriate case manager list that is 

affiliated with the corresponding agency in cell C2. 

 
Lastly, in cell I4, we use a FILTER function to extract the clients who are assigned to the listed 

case manager in I2. 

 
‘SA - CM A’ Tab 

 

● In cell A1, we use INDEX to transfer over the headers 

● In cell A2, we use the FILTER function to transfer over Case Manager A’s clients only. 

● If you scroll all the way to the right, we’ve included sample columns of additional 

information that the case manager may want to collect on his/her clients. For example. 

We’ve used DR:DU to input weekly case notes. We’ve also inserted a housing status 

column (column DV) as well as columns for document status (DW:DZ). This may be 

where the case manager can manually update based off her interactions with clients. 

 
‘CM A alt view’ Tab 

 

● This is an alternative view of the ‘SA - CM A’ tab. The ‘SA - CM A’ tab houses data in 

spreadsheet format. We’ve organized this alt view tab so that the case manager can find 

detailed information in vertical format for each client. In cell C2, we’ve used data 

validation, against a range from the ‘SA - CM A’ tab column DM. 

● This tab pulls data FROM the SA - CM A tab and does not allow for data to go BACK 

into the SA - CM A tab, meaning, data cannot be inserted in columns D (client 

responses) or G (case mgmt) as there are formulas that will pull the data for view only. 
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‘Agency Level - SA’ Tab 

 

Lastly we have the ‘Agency Level - SA’ tab. This is very similar to the ‘Macro level’ tab, however, 

it is for one specific agency level view. The one difference is that we have included column J for 

the housing process status for each of the clients. Because we are pulling in data from three 

tabs: 

(1) SA - CM A 

(2) SA - CM D 

(3) SA - CM G 

We use a combination INDEX & MATCH formula that will pull from all three sheets with an 

IFERROR formula. 

 

IFERROR Function21
 

Returns the first argument if it is not an error value, otherwise returns the second argument if present, or a 

blank if the second argument is absent. 

 
Syntax:  IFERROR(value, [value_if_error]) 

● value - The value to return if value itself is not an error. 

● value_if_error - [ OPTIONAL - blank by default ] - The value the function returns if value is an 

error. 

 

‘Agency Level - SA’ Tab in Case MGMT Sample: 

Cell J3 Formula 

=iferror(INDEX('SA - CM A'!DV:DV, match(I3, 'SA - CM A'!DM:DM, 0)),"")&iferror(INDEX('SA - CM 

D'!DV:DV, match(I3, 'SA - CM D'!DM:DM, 0)),"")&iferror(INDEX('SA - CM G'!DV:DV, match(I3, 'SA - CM 

G'!DM:DM, 0)),"") 

 
Note: 

Let’s break up the first section: 

iferror(INDEX('SA - CM A'!DV:DV, match(I3, 'SA - CM A'!DM:DM, 0)),"") 

 
This first section is matching the contents in the left cell (client info), to the appropriate housing process 

data from SA - CM A’s tab. However, because this is agency level data, there is a drop down menu that 

may change the name of the case manager - thus, we use the “&” symbol to include the other case 

managers’ clients at this agency. We also use the IFERROR to wrap each section of the formula so that 

we do not have any error values in the cells. 

 
We then clicked and dragged the formula to cell J60, leaving sufficient room for the number of potential 

clients a case manager may have. 

 
 
 
 
 
 
 

21     https://support.google.com/docs/answer/3093304?hl=en 

https://support.google.com/docs/answer/3093304?hl=en
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Maintaining your By-Name List (BNL) 

 
You may use a case mgmt-type spreadsheet to maintain your BNL. If you’d like to learn more 

about the By-Name List, the following documents are helpful places to start: 

● 20K By-Name List Recommendations for Practice V1.0 [Adopted from Zero] 

● By-Name List Data Guidance [Adopted from Zero] 

 

You may use a case mgmt-type spreadsheet such as the Case MGMT Sample: Sample Cmty - 

5/27/16 sheet that was referenced. 

 
To ensure that new inflows of clients are also reflected on your BNL, you can continue using 

your common assessment google form. The following steps outline how you can capture the 

new inflows of clients on your BNL: 

1. Ensure that those who come in contact with potential clients who are experiencing 

homelessness are also continuously using the common assessment google form. 

2. You may adjust your form response spreadsheet so that you receive email notifications 

when a form is submitted. To receive or edit notifications, open up your form response 

spreadsheet > click ‘Tools’ in your toolbar > click ‘Notification rules…’ > and the window 

below will appear. Set your notification settings to your liking and click save. 

 

3. Make sure to copy and paste new form responses from your form response spreadsheet 

into your data mgmt - Component B: The Tidy Data Set + Formulas set tab and that you 

tidy up the data as well. 

4. If you have a similar case mgmt spreadsheet as the referenced Case MGMT Sample: 

Sample Cmty - 5/27/16 sheet that pulls data from your data mgmt spreadsheet, this 

should be automatically updated when you paste in new form responses into your data 

mgmt spreadsheet. 

https://docs.google.com/document/d/1Hj-LAypk6FIuw-jkA3AM9JMh3sXTZgQIVwQCDsl7j0c/edit?usp=sharing
https://docs.google.com/document/d/1lVaMloXJmq8sFtPuP-Gp702MJb2LN5yccIc4yLCg2P4/edit
https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
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5. Using formulas such as the ones in the previous section Sample Case Management 

Google Sheet, you can consolidate all case manager’s data on clients to pull into one 

sheet that may house your by-name list. 

 
Important Note: Please make sure that your by-name list includes all relevant recommended 

data fields (which can be found in the By-Name List Data Guidance [Adopted from Zero] google 

doc). 

https://docs.google.com/document/d/1lVaMloXJmq8sFtPuP-Gp702MJb2LN5yccIc4yLCg2P4/edit
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PART VII: Premade VI-SPDAT 2.0 (CANADA) Data Platform 

 
If you are a community using the VI-SPDAT (Canadian version 2.0) common assessment , this 

portion of the guide will review the steps on how you can copy a premade data system for your 

registry week to use as your own. 

 
Please note: If you’ve read through the previous parts of this guide, some information may be 

redundant. 

 
Below are the google system links that you will copy/use/create to copy your VI-SPDAT Data 

Platform. 

 

VI-SPDAT Data System Links 

A. Sample Community VI-SPDAT (CA V.2.0.) - 5/27/16 (EDIT) 

 
VI-SPDAT Google Form: EDIT version - accessible to the creator/editor of the Form 

(and a limited number of other collaborators). This is a Google Form replica of the 

paper version of Sample community’s VI-SPDAT (Canadian version 2.0) pdf 

document. 

B. Sample Community VI-SPDAT (CA V.2.0.) - 5/27/16 FORM RESPONSES 

 
VI-SPDAT Form Response Spreadsheet - google spreadsheet where all the raw 

data from your google form is housed. Community’s VI-SPDAT system 

administrator will create (details on how to create this will be in this how-to 

document) 

C. Sample Community VI-SPDAT (CA V.2.0.) - 5/27/16 (LIVE) 

 
VI-SPDAT Google Form: LIVE version - this is the same as the edit version, but in 

the fillable format which is accessible to data entry persons (the URL link can be 

accessed and used by multiple people simultaneously) 

D. DATA MGMT: SAMPLE Cmty name  - VI-SPDAT (CA V.2.0.) - 5/27/16 

 
Data MGMT Spreadsheet - with your (a) code book, (b) your tidy data set and 

formulas, (c) dashboards, (d)* any additional analyses 

https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/edit?uiv=0
https://drive.google.com/a/cmtysolutions.org/file/d/0B0L-3OLIyBxLTk9EOXZRSzZSaUU/view
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D454063210
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Step 1: Create a Google Account for your Community (if you don’t have one already) 

 

I. Creating a google account: If you do not yet have a google account, you may sign up for 

one here → https://accounts.google.com/SignUP 

 

II. Start by signing in to your account. 

4. Go to www.google.com and in the top-right corner, click Sign in. 

5. Enter your Google Apps email address (example: joe@company.com) and 

password. 

6. Click Sign in . 

 
Now that you’re in your Google Apps account, here are a few key features that work the same 

way across several products: 

 

 
 

III. The Google Drive22
 

your Google account. 

is an online file storage that is automatically attached with 

A. The Drive is where you may access the Google Docs Editors. 

1. Store any files or folders from your computer 

2. Keep Drive organized with folders 

3. Share files with your team 

4. Remove, permanently delete, or restore files 

B. You may access your Drive: 

1. Using this link → drive.google.com 

2. Or after signing in to your Google account, you may access your drive by 

clicking on the  icon on the top right-hand corner of your browser 

window, then clicking on the Drive icon. 

 
 
 
 

22  For more info on the Drive:    https://apps.google.com/learning-center/products/quickstart/#step-4 

https://accounts.google.com/SignUP
http://www.google.com/
https://drive.google.com/
https://apps.google.com/learning-center/products/quickstart/#step-4
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IV. The Drive is where you may also create, edit, and access the Google Docs Editors23. 

The Docs Editors are collaborative, web-based, “applications” - where each application 

functions for different purposes: 

 

 
V. All links that you will be either copying, creating, or using will be focusing mainly on the 

following three Docs Editors applications: 

A. Google Docs 

B. Google Sheets 

C. Google Forms 

 
A. COPYING - VI-SPDAT Google Form: EDIT Version 

 
Step 2: Request Edit Access to the VI-SPDAT Google Form: EDIT Version 

 

I. The first link [Sample Community VI-SPDAT (CA V.2.0.) - 5/27/16 (EDIT)] is not what 

an edit version of a google form will look like. Google forms do not allow copying of live 

versions of google forms without editing privileges. Thus, we will have to provide you 

with edit access to a secondary copy of this VI-SPDAT google form. 

II. To obtain access to a secondary copy of the VI-SPDAT google form, please email 

hkim@cmtysolutions.org, and insert in the subject line: “RE: VI Google Form Request for 

Access [NAME OF CMTY]”. In the body of the email, please provide the following 

information: 

A. Name of Registry Week community you are representing 

B. Dates of Registry Week 

C. Intention of use for the google system 

D. Name of data point of contact for your Registry Week community and their 

contact information 

 

23  For more info on Docs Editors:    https://apps.google.com/learning-center/products/quickstart/#step-5 

https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/edit?uiv=0
mailto:hkim@cmtysolutions.org
https://apps.google.com/learning-center/products/quickstart/#step-5
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III. Once we receive a request access from you and have verified your intent of use, we will 

give you editing access to a secondary copy of the VI-SPDAT google form. 

A. Please note: We will remove editing access to the VI-SPDAT google form 

after you create a copy of it on your account. 

IV. After you receive access to the VI-SPDAT google form, and open the edit version of the 

form, it should look something like the images pasted below. 

 

New edit version of Google Forms Older edit version of Google Forms 

 

 
 

 

 
 

 

V. The steps in this section, we’ll be using the older version of Forms. If you have the newer 

version of Forms open, you can revert this to the older version by clicking on the “?” 

button at the bottom right corner of your window and clicking “Back to the old Forms”. 
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Step 3: Create a copy of the VI-SPDAT Google Form: EDIT Version 

 

I. Once you’re in the older edit version of google forms for the VI-SPDAT Google Form, at 

the top left of the toolbar, click ‘File’. A drop down menu will appear, click ‘Make a copy’, 

and the following window will appear: 

 

II. You may go ahead and change the name of the VI-SPDAT Google Form to your liking. 

And please make sure that the chekcbox left of “Share it with the same people” is NOT 

checked off and click the blue ‘OK’ button. 

III. Now you have a copy of the VI-SPDAT Google Form under your google account! 

IV. In your copy of the VI-SPDAT Google Form, you will want to check the following: 

Form Settings 

A. You will want to make sure that your ‘Form Settings’ are adjusted properly. Your 

Form Settings may look like this if your account is under a Professional/Business 

Google Account: 

 

 
Or it may look like this with the basic/free Google Account: 

 
B. For either account types; you will want to have none of the checkboxes checked 

in and the ONLY checkbox that can be checked (if you prefer) is the one left of 

“Show progress bar at the bottom of form pages”. 
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Form Title 

C. You will want to change the title of your Google Form. ‘Title Name #1’ (in the 

image below) is the title for the EDIT version of your google form which you 

should have already renamed when you created the copy. This title is only 

viewable to the internal editors/collaborators of your google form (if any) who also 

have edit access. If you’d like to rename ‘Title Name #1’, you may do so by 

clicking on it directly. 

D. ‘Title Name #2’ (in the image below) is the title that will show in the LIVE version 

of your VI-SPDAT google form and will be viewable to those filling out the form 

such as your data entry persons. You may change Title Name #2 to your liking. 

 

V. You will want to delete the form responses spreadsheet after the initial copy of the 

google form. Please click “View responses” under the top toolbar. 

 

A. If a spreadsheet does NOT open up but instead you see the following window, 

then please CLICK THE “X” at the top right hand corner of the window. 



Page  |  65  

 

B. If a spreadsheet opens up with “...(Responses)” at the end of the title of the 

spreadsheet, then you will need to “Unlink form” so that the responses are not 

housed in that spreadsheet but are instead housed within the google form itself 

(until AFTER data entry of actual client assessments are complete). In your EDIT 

version of the VI-SPDAT google form, click “Responses (0)” in the top toolbar > 

then click “Unlink form”. 

 

The following window will pop open. Please go ahead and click “Unlink” 
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Go to your “...(Responses)” spreadsheet (which is now unlinked) > click “File” > 

then click “Move to trash”. The window below will open > click “Go to Sheets 

home screen” 

 

 
Important Notes: for your VI-SPDAT Google Form: EDIT Version 

 

● If any question items are newly created, edited, rearranged, and/or deleted, the 

latter copies of data mgmt and case mgmt sheets may require editing or may not 

be applicable for your edited VI-SPDAT google form. 

○ If you are doing minimal editing and require assistance with editing the data 

mgmt and/or case mgmt sheets, please let us know at hkim@cmtysolutions.org. 

● We HIGHLY recommend that ALL edits to the google form be finalized BEFORE your 

google form is used for data entry of actual clients’ common assessments to reduce the 

chances of inaccurate/misplaced data. 

● The Share your form with collaborators link goes over how you can add additional 

collaborators for the edit version of your form, however, we suggest that you limit the 

number of collaborators to curb the chances of accidental edits being made after the 

form is being used for data entry of actual common assessments. 

 
B. CREATING - VI-SPDAT Form Response Spreadsheet 

 
Step 4: Choosing a form response destination24

 

 

In your form, click “View responses” in the toolbar. Once you click “view responses”, a window 

will pop open, such as the one shown below. You will want to select “New spreadsheet” which 

creates a new spreadsheet in Google Sheets for your form responses. 

 
 
 
 
 
 
 
 
 

 

24      https://support.google.com/docs/answer/2917686?hl=en&ref_topic=6063584 

mailto:hkim@cmtysolutions.org
https://support.google.com/docs/answer/2917111?hl=en&amp;ref_topic=6063584
https://support.google.com/docs/answer/2917686?hl=en&amp;ref_topic=6063584
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Step 5: Checking Form Response Spreadsheet Column Sequence 

 

Your form response spreadsheet’ first row should have all of the question titles in the exact 

sequential vertical order of the edit version of your form for each question items created. 
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If any question items on your google form were newly created, edited, rearranged, and/or 

deleted AFTER your form response spreadsheet was created, the sequence of questions in 

your responses spreadsheet may not be in the revised sequence you have on your google form 

(e.g. a deleted question may still appear in your responses spreadsheet; a newly created 

question may appear in the last column instead of it’s appropriate place). If this is the case, you 

will want to UNLINK the form from the spreadsheet, delete the delinked spreadsheet, and 

recreate a new spreadsheet for your responses so that the vertical sequence of questions in 

your google form are the exact same sequence in your form response spreadsheet (steps on 

unlinking and deleting your spreadsheet are on the C. Delinking Your Responses Spreadsheet 

section of the guide). 

 
Please keep in mind that the first column of your form response spreadsheet will always house 

the “timestamp” column. When a form is created, this is automatically generated (collects data 

on the exact date/time a data entry person clicks “submit” on the google form). 

 
Again, we HIGHLY recommend that ALL edits to the google form be finalized BEFORE your 

google form is used for data entry of actual clients’ common assessments to reduce the 

chances of inaccurate/misplaced data. Once you have the final version of your google form in 

the accurate order and all edits are finalized, please double check one last time to make sure 

the sequencing is accurately reflected in your form response spreadsheet. 

 
C. USING - VI-SPDAT Google Form: LIVE Version 

 
You can access the LIVE version of your form by clicking ‘view live form’ under the top toolbar. 

 
Step 6: Filling out sample assessments 

 

BEFORE your google form is used for data entry of actual clients’ common assessments, we 

highly recommend that you fill out sample assessments (not actual client surveys but fake 

responses) to get a feel for the google form and to also check for data validity: 

 
I. Fill out and submit sample assessments in the live version of your google form. 

II. Double check the accuracy of responses of the sample assessments in your responses 

spreadsheet. 

III. Then delete25 the responses of the sample assessments in your google form. You can 

delete the sample assessments by clicking the “Responses” menu and then selecting 

“Delete all responses”. You will also want to check your form response spreadsheet and 

delete the rows that have sample assessments as well. 
 

25      https://support.google.com/docs/answer/2923993?hl=en&ref_topic=6063584 

https://support.google.com/docs/answer/2923993?hl=en&amp;ref_topic=6063584
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Important Note: Once you start using your google form for data entry of actual clients’ common 

assessments, please keep in mind, you do NOT want to delete any responses. If there is an 

accidental submission or duplicate submission, you may delete the row in your responses 

spreadsheet, but otherwise, you do NOT want to “delete all responses”. In addition please do 

NOT unlink your form during data entry. 

 
Step 7: Data Entry 

 

Depending on how you plan to conduct registry week, you may decide to have surveyors use a 

paper version of the VI-SPDAT or use the VI-SPDAT Google Form via web-based tablets or 

phones. 

 
Once data entry is ready to begin, please note the following for those who will be entering the 

data into the google forms: 

● For data entry persons, they will be using the LIVE version of the google form and 

multiple data entry persons may use the LIVE version URL link of the google form 

simultaneously. Data Entry persons will NOT need access to the EDIT version of the 

google form. 

● When data entry persons are using the google form, there may be help text underneath 

the questions, please ask data entry person(s) to read the help text carefully as 

incorrectly formatted responses entered may affect the way data is calculated/analyzed 

for administrators who are using separate data dashboards that will be connected to the 

responses entered in the form. 

 
D. COPYING: Data MGMT Spreadsheet 

 
Step 8: Copy the Data MGMT Spreadsheet 

 

I. Click on the DATA MGMT: SAMPLE Cmty name - VI-SPDAT (CA V.2.0.) - 5/27/16 

link. Once you have the sheet open, click ‘File’. A drop down menu will appear, click 

‘Make a copy’, and the following window will appear: 

 

https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D454063210
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D454063210
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II. You may go ahead and change the name of the Data MGMT spreadsheet to your liking. 

And please make sure that the checkbox left of “Share it with the same people” is NOT 

checked off and click the blue ‘OK’ button. 

III. Now you have a copy of the Data MGMT spreadsheet under your google account! 

 
Your Data MGMT spreadsheet houses the following tabs: 

● Tab 1: Code Book 

○ This is a reference place that lists out the VI-SPDAT form questions, response 

options for each question, scoring prompts, formulas for scoring prompts, 

spreadsheet column header letters, etc. 

● Tab 2: Form Responses 1 

○ This tab is where you will copy and paste your raw client data from your 

responses sheet. This tab also include pre-made formulas to calculate VI-SPDAT 

scores. Additionally this is where the data will be pulled from for the third tab. 

● Tab 3: Dashboards 

○ This tab stores tables and charts of your people who were assessed, using 

preset formulas. 

 
Step 9: Copying/Pasting the raw client data into your Data MGMT Spreadsheet 

 

I. In the ‘Form Responses 1’ tab of your data mgmt spreadsheet, you will notice that rows 

4 - 295 are filled in with sample data. Please delete those rows only. You can delete by 

clicking and dragging the row label numbers (placed on the very left side of the sheet) 4 

through 295 > right click > and click ‘Delete rows 4-295’. 

II. Open up your form response spreadsheet that is linked to your VI-SPDAT google form, 

highlight the entire sheet and copy your raw data. 

A. Shortcut for highlighting: Near the top left, where the column titles (A, B, C, 

D….) meets the row titles (1, 2, 3, 4….), click on the box where A and 1 meet 

(this is the small box right below fx). Once you click this box, the entire 

spreadsheet should be highlighted. Please copy. 

III. Go back to the ‘Form Responses 1’ tab of your data mgmt spreadsheet. Click on cell A4 

(very important: do NOT copy into cell A3 as row 3 has formulas), then paste the 

copied raw data. 

A. Because you pasted the entire responses spreadsheet (including the first row 

which only has the questions as the header), 

1. First, please check to make sure the column headers in the “Form 

Responses 1” tab row 1, match up to the copied headers in row 4. If the 

headers DO NOT MATCH UP, please contact 

hkim@cmtysolutions.org 

2. Second, you will need to delete row 4 (this should be the header 

questions). You can do this by clicking on the “4” at the very left column, 

right click, then click “delete row” from the drop down menu that opens. 

mailto:hkim@cmtysolutions.org
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B. Please scroll all the way to the right of the “Form Responses 1” tab sheet to 

columns CF:DC - and please make sure that the cells autopopulate in those 

columns. 

C. Please also check the “Dashboards” tab to see that the cells autopopulate with 

numbers/percentages and that the graphs are accurate. 

 
Step 10: Tidying up your ‘Form Responses 1’ tab. 

 

You will want to ensure that all responses are correctly submitted. For example, if you have a 

question that requires numerical responses, such as the question “How long has it been since 

you lived in permanent stable housing? (in months)”, and the response options are a numerical 

value or the word ‘refused’, you will want to double check that column to ensure that all 

responses are standard and that no one has submitted an assessment with a response outside 

of the perimeters of the response options you are looking for. To easily check your raw data, 

you may use filtering (see Appendix II, 7) Filter your Data) or conditional formatting (see 

Appendix III, A. HOW TO USE CONDITIONAL FORMATTING). 

 
Additional notes on the “Form Responses 1” tab of the spreadsheet: 

1. If you see "#VALUE!" or "#NUM!" in the cells underneath the formula columns (red filled 

to the right of the ‘Form Responses 1’ spreadsheet) - the corresponding response might 

be incorrect (e.g. DOB is incorrectly written, or "refused" is spelled incorrectly, etc) 

2. If this hasn’t been done already: in the dashboard spreadsheet - within 'Form Responses 

1' tab - you may want to lock (limit permission levels for) the columns with all of the 

formulas. You may also want to lock (limit permission levels for) the 'dashboards' tab. 

a. You can set permission levels by clicking “data” (in toolbar) > “protected sheets 

and ranges”. 

b. When the right panel opens, click “add a sheet or range”, enter a description; 

click “range” and then click on the grid icon highlight the rows/columns you want 

to lock permissions for or click  “sheet” and then “set permissions”. 

3. The cells under column CF, CG, & CX will show “FALSE” as the text - please do not be 

alarmed! This is okay! It just means that for empty rows, a response of “FALSE” will 

autogenerate because of the formula that is being used. This does not affect the scoring! 

4. Please DO NOT delete the THIRD row sample (highlighted in red) as this is where the 

formulas will be - the “Dashboards” tab will not incorporate the third row sample data. 

5. Please DO NOT move the columns or delete any empty columns/rows or cells in 

ANY tabs as this may affect data validity and dashboards. 

 

Step 11: Using the ‘Dashboards’ tab 

 

All cells in your ‘Dashboards’ tab should auto populate once the raw client data responses from 

your form responses spreadsheet are copied into the ‘Form Responses 1” tab. The only cells 

from the “Dashboards” tab that are NOT auto populated are the cells below. You will have to 

manually type in the appropriate numbers for those cells: 
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● D6: Total people talked to 

● D7: Total surveys submitted 

● D8: Total refusals/unable to connect 

● (note: cells E6, E7, E8 - WILL auto populate once you manually input numbers for D6, 

D7, D8) 

 
Important Additional Notes: 

● Please DO NOT rename ANY tabs as the “Dashboards” tab houses formulas that 

auto-populate data from other tabs. 

● Please let us know if you would like us to further customize your dashboards in the 

“Dashboards” tab. 
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APPENDIX 
 
 
 
APPENDIX I: QUICK LINKS REFERENCE LIST 

 

Google Links 

Google Apps Learning Center 

Google Account: Signing Up 

Info on Google Drive 

Info on Google Docs Editors 

Google docs editors HELP LINK 

Google spreadsheets function list 

Homelessness Campaign Info Links 

Registry Week Information (100,000 homes campaign) 

20K By-Name List Recommendations for Practice V1.0 [Adopted from Zero] 

By-Name List Data Guidance [Adopted from Zero] 

Sample Community VI-SPDAT System Links 

Sample community's VI-SPDAT (Canadian version 2.0) pdf 

Sample Community VI-SPDAT (CA V.2.0.) - 5/27/16 (google form) 

DATA MGMT: SAMPLE Cmty name - VI-SPDAT (CA V.2.0.) - 5/27/16 

Case MGMT Sample: Sample Cmty - 5/27/16 

https://apps.google.com/learning-center/products/quickstart/#step-1
https://accounts.google.com/SignUP
https://apps.google.com/learning-center/products/quickstart/#step-4
https://apps.google.com/learning-center/products/quickstart/#step-5
https://support.google.com/docs/topic/2811806?hl=en&amp;rd=1
https://support.google.com/docs/table/25273?hl=en
http://100khomes.org/sites/default/files/images/Registry%20Week%20PIT%20Integration%20Toolkit_FINAL.pdf
https://docs.google.com/document/d/1Hj-LAypk6FIuw-jkA3AM9JMh3sXTZgQIVwQCDsl7j0c/edit?usp=sharing
https://docs.google.com/document/d/1lVaMloXJmq8sFtPuP-Gp702MJb2LN5yccIc4yLCg2P4/edit
https://drive.google.com/file/d/0B0L-3OLIyBxLTk9EOXZRSzZSaUU/view?usp=sharing
https://docs.google.com/a/cmtysolutions.org/forms/d/1WyuDsWsF1HWZ1askyupaf2_QQaJyA70gww3S949flpE/viewform
https://docs.google.com/spreadsheets/d/1X83RORYrcviWPvMFOZ6yafQr1A6SYDRzFj48KCc-kbU/edit#gid%3D1268652324
https://docs.google.com/spreadsheets/d/1MVdazZRBjIhHwxTb0PCqwHR2p_38asEIpiX7FMlLfRU/edit#gid%3D1325926501
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APPENDIX II: GET STARTED ON GOOGLE SHEETS (Introductory) 

 
A. Create, Edit, and Format 

https://support.google.com/docs/topic/1361470?hl=en&ref_topic=2811806 

 

1) Edit and format data in google spreadsheets 

https://support.google.com/docs/answer/46973?hl=en&ref_topic=1361470 

 

You can either add content to an empty cell in your spreadsheet or edit a cell that already has 

content. 

● Add content to an empty cell: Click the cell and start typing. 

● Edit a cell that already has content: Double-click the cell you want to edit. 

● Add a line break in a cell: To create a line break within a cell while editing, place your 

cursor in a cell and press Ctrl+Enter (Cmd+Enter on a Mac). You can use this feature to 

improve the look of text that requires line breaks, such as addresses. 

 
2) Merge cells https://support.google.com/docs/answer/141104?hl=en&ref_topic=1361470 

 

You can combine cells together in documents, spreadsheets, or presentations by merging them. 

You can also wrap text in a spreadsheet so that you can see all the text inside a cell. To 

combine cells horizontally and/or vertically in a spreadsheet: 

1. Highlight the cells you want to combine. 

2. On the toolbar, click Merge . 

 
From the Merge drop-down menu, you can select from the following options: 

● Merge all: Merges selected cells into one cell. 

● Merge cells horizontally: Merges the cells in each selected row. 

● Merge cells vertically: Merges the cells in each selected column. 

 
To unmerge a selected range of cells: 

● Highlight the cells you want to unmerge. 

● In the toolbar, click Merge . 

● Click the arrow to the right of the icon > Unmerge. 

 
3) Wrap text 

 
In a spreadsheet, text that is longer than its cell will overflow into the cell next to it if it's empty, 

making the full text visible. If the adjoining cells are already full, your text will be clipped off in 

order to fit. However, if you wish to make it visible, you can wrap the text. If you want the text in 

the cell to wrap onto a second line in the cell: 

 
● Select the cell. 

● In the toolbar, click Wrap text wrap text. 

https://support.google.com/docs/topic/1361470?hl=en&amp;ref_topic=2811806
https://support.google.com/docs/answer/46973?hl=en&amp;ref_topic=1361470
https://support.google.com/docs/answer/141104?hl=en&amp;ref_topic=1361470
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● Click the icon again to turn text wrapping off. 

 
B. Work with sheets, rows, and columns 

https://support.google.com/docs/topic/1361469?hl=en&ref_topic=2811806 

 

1) Freeze or unfreeze columns and rows 

https://support.google.com/docs/answer/54813?hl=en&ref_topic=1361469 
 

To keep some of your data in the same place as you scroll through a spreadsheet, for example headings or 

labels, you can freeze rows or columns. 

 

Freeze rows or columns 

1. Open a spreadsheet and select a cell in a row or column you want to freeze. 

2. Open the View menu. 

3. Hover over Freeze. 

4. Select one of the options to freeze up to ten rows, or five columns. You can also choose Up to 

current row (or Up to current column) to freeze the rows or columns before a cell you've 

highlighted. 

Unfreeze rows or columns 
1. Open a spreadsheet and select a cell in a row or column you want to unfreeze. 

2. Open the View menu. 

3. Hover over Freeze. 

4. Choose either No rows or No columns to unfreeze your rows or  columns. 

 
2) Add and delete rows or columns in a spreadsheet 

https://support.google.com/docs/answer/44684?hl=en&ref_topic=1361469 

 
To add a row or column to a spreadsheet, right-click on the gray area containing the column letter or the row 

number. Select the action that you'd like to complete. For example, to insert a blank column to the left of the 

column you selected, you'd select Insert 1 left from the drop-down menu. To delete a row or column, select 

Delete row or Delete column from the drop-down  menu. 

 
If you'd like to insert multiple rows or columns, highlight the number of columns or rows you wish to insert. 

Then, right click the column or row header, and select "Insert N..." For example, if you highlight five rows, 

right click the row header, and select Insert 5 above or Insert 5  below. 

 
To add a large number of rows (100+) to your spreadsheet all at once, scroll to the bottom of the 

spreadsheet. In the text box, enter the number of rows you'd like to add and click the Add button. 

 
3) Copy a sheet 

https://support.google.com/docs/answer/180897?hl=en&ref_topic=1361469 

 

You can make a duplicate copy of any sheet in a spreadsheet. That copy can be made within 

the same spreadsheet or into another, separate spreadsheet. 

 
Here's how to copy a sheet to another spreadsheet: 

https://support.google.com/docs/answer/54813?hl=en&amp;ref_topic=1361469
https://support.google.com/docs/answer/180897?hl=en&amp;ref_topic=1361469
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1. At the bottom of a spreadsheet, click the down arrow next to the sheet name to open the 

sheet menu. 

2. From the menu, click Copy to. 

3. Choose the destination spreadsheet from the list. 

4. Click Select. 

5. If there's already an existing sheet with the same name, the copied sheet will be named 

"Copy of sheetname." 

 
To copy one sheet within a spreadsheet, follow these steps: 

1. Click the down arrow next to the sheet name to open the sheet menu. 

2. From the menu, select Duplicate. 

3. A duplicate sheet (which contains the exact formatting) will appear in a new tab beside 

the original sheet. It's labeled Copy of Sheet. 

 
4) Protect a range or sheet from being edited 

https://support.google.com/docs/answer/144687?hl=en&ref_topic=1361469 

 

Protect a range or sheet 

 
1. Open a spreadsheet. 

2. Select a cell or range of cells. 

3. Click the Data menu and select Protected sheets and ranges. 

4. In the box that appears on the right, take an action: 

● Add a description (optional). 

● To protect a range, click Range. To protect a sheet, click Sheet. 

● Range:Change or enter the range you’re protecting. To do this, click on the 

spreadsheet grid icon and highlight the range in the spreadsheet. If you chose a 

cell or range earlier, it’ll appear automatically. 

● Sheet:Choose a sheet to protect. If you want a set of cells to be unprotected in a 

sheet, check the box next to “Except certain cells.” 

5. Click Set permissions or Change permissions. 

6. Choose how you want to limit editing: 

● Select "Show a warning when editing this range" to show a warning when anyone 

makes an edit. It doesn’t block people from editing, but they’ll see a message 

asking them to confirm if they really want to make an edit. This can be useful to 

prevent typos (even from yourself). 

● Select "Restrict who can edit this range" and choose who can edit the range or 

sheet: 

○ Everyone: Anyone can edit the range or sheet. 

○ Only you: Only you (and the owner if you’re not the owner) can edit the 

range or sheet. 

https://support.google.com/docs/answer/144687?hl=en&amp;ref_topic=1361469
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○ Only domain: If you use Google Apps for work or school, only people in 

your domain can edit the range or sheet. This option is only available 

when everyone in your domain can edit the spreadsheet. 

○ Custom: Only the people you choose can edit the range or sheet. 

○ Copy permissions from another range: Reuse the same permissions you 

set up on a different set of cells or sheet. 

7. Click Save or Done. 

8. To see protected cells you can’t edit, click the View menu > Protected ranges. A striped 

background will appear over the cells. 

 
Who can create a protected range or sheet: 

 
● If you own a spreadsheet: You can set editing permissions for ranges and sheets. 

● If you can edit a spreadsheet: You can set editing permission but can’t remove editing 

permission for owners. 

● If you can view or comment on a spreadsheet: You won't be able to make any changes 

or delete a protected range or sheet. 

 
Edit a copy of a protected sheet: To edit data in a copy of a protected sheet 

 
● If you have “edit” permissions: Make a copy of the protected sheet, copy the workbook, 

or upload a new version. 

● If you have “view” permissions: Make a copy of a spreadsheet. 

● Warning: Protected ranges and sheets can help stop people from changing a 

spreadsheet, but they shouldn’t be used for security purposes because not all actions 

are blocked. Other people can still print, copy and paste, and import and export copies of 

a protected spreadsheet. Only share spreadsheets with people you trust. 

 
5) Hiding rows and columns 

https://support.google.com/docs/answer/58142?hl=en&ref_topic=1361469 

 
Hiding and unhiding rows 

To hide a row, right-click the number of the row to highlight the entire row. Select Hide row from 

the drop-down menu. An icon appears over the hidden row, and the row's number is no longer 

visible. 

To unhide a row, just click the icon and the row reappears on the spreadsheet. 

 
Hiding and unhiding columns 

To hide a column, right-click the letter of the column to highlight the entire column. Select Hide 

column from the drop-down menu. An icon appears, showing the letter of the column that's 

been hidden. If you have two or more adjacent columns hidden, the icon will show the range of 

letters, such as B-E. 

To unhide a column, click the letter icon and the column reappears. 

To hide multiple, adjacent rows or columns all at once, follow these steps: 
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1. Click the row number or column letter of the first row/column you want to hide. The 

row/column is highlighted. 

2. Press and hold Shift on your keyboard while clicking the last row number or column 

letter you want to hide. 

3. All rows or columns in the range are highlighted. 

4. Right-click anywhere in the highlighted range, and choose Hide rows from the 

drop-down menu. 

To unhide several hidden rows or columns all at once, just highlight the range and select 

Unhide rows/columns. For example, if you have columns C and H hidden, you can select 

columns B-I, right-click anywhere in the selected range, and choose Unhide columns. All 

hidden columns in the range will reappear. 

 
6) Hide a sheet from view 

https://support.google.com/docs/answer/1218656?hl=en&ref_topic=1361469 

 
Google spreadsheets allows you to take individual sheets out of view by hiding the sheet. This 

feature is particularly useful if you have individual sheets that are old, rarely used, or are 

placeholders for calculations used by other sheets. 

Note: Hiding a sheet is not the same as protecting a sheet. All editors on the spreadsheet will 

be able to unhide and view these sheets. Spreadsheet viewers will not be able to view hidden 

sheets. 

How to hide and unhide a sheet 

To hide an individual sheet in your spreadsheet, follow these steps: 

1. Click on the sheet tab that you’d like to hide. 

2. Select Hide sheet from the sheet tab menu. If your spreadsheet doesn’t contain two 

or more sheets, this option won’t show. 

3. Your sheet will be hidden from view. 
 
To unhide a sheet in your spreadsheet, follow these steps: 

1. From the View menu, scroll to Hidden sheets. If your spreadsheet doesn’t contain 

any hidden sheet, this option will be greyed out. 

2. Scrolling to the Hidden sheets menu item will expand an additional menu that 

displays all of your hidden sheets. 

3. Alternatively, you can click the sheet menu button. Hidden sheets will be shown in 

grey. 

4. Select the sheet that you no longer want hidden. 

5. Notice that your sheet now shows with the rest of your sheet tabs at the bottom of 

your spreadsheet. 

 

Note: If you, your spreadsheets viewers, or spreadsheet editors make a copy of the sheet (File 

> Make a copy) hidden sheets will be preserved, but they will be able to unhide the sheets. 

Additionally, data contained in hidden sheets will be accessible via Google Apps Script and the 

Google Data API. 

https://support.google.com/docs/answer/144687
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Importing and exporting spreadsheets with hidden sheets 

Hidden sheets will remain hidden if importing or exporting your spreadsheet from the following 

formats: 

● Exporting the spreadsheet to .pdf, .xls, or .ods format 

● Importing the spreadsheet from .xls, .xlsx, or .ods format 

● Spreadsheet List view 

○ If you include the page parameter (#gid=N) in List view, however, the hidden 

sheet will show 

● Exporting the spreadsheet to html with the "/ccc?output=html" parameter 

○ If you include the page parameter (#gid=N) in the URL, the hidden sheet will 

show 

● Publishing the spreadsheet 
 
Work with data https://support.google.com/docs/topic/1361472?hl=en&ref_topic=2811806 

 

7) Filter your Data 

https://support.google.com/docs/answer/3540681?hl=en&ref_topic=1361472 

 

To easily see and analyze data in a spreadsheet, use filters. Filters let you hide data that you 

don’t need to see. You’ll still be able to see all your data when you turn the filter off. 

Note: When you add a filter, anyone with access to your spreadsheet will see the filter too. 

Anyone with permission to edit your spreadsheet will be able to change the filter. 

 
To filter your data: 

1. Open a spreadsheet in Google Sheets. 

2. Select a range of cells. 

3. Go to the “Data” menu and select Filter. You can also go to the toolbar and click the filter 

icon toolbar icon. 

4. To see filtering options, click the down arrow to the right of the filter dropdown button. 

● Filter by condition: Choose from a list of conditions or write your own. For 

example, if the cell is empty, if data is less than a certain number, or if the text 

contains a certain letter or phrase. 

● Filter by value: Uncheck any data points that you want to hide and click OK. If 

you want to choose all data points, click Select all. You can also uncheck all data 

points, by clicking Clear. 

● Search: Search for data points by typing in the search box. For example, typing 

"P" will shorten your list to just the names that start with P. 

5. To turn the filter off, go to the “Data” menu and select Turn off filter. You can also click 

the filter icon. 

 
Note: Only one filter is allowed per spreadsheet so that people don’t overwrite each other’s 

data. If you want more than one filter on a sheet, use filter views. When you turn off and delete 

the filter, you’ll see all of your data but anything you’ve sorted will stay sorted. 

https://support.google.com/docs/topic/1361472?hl=en&amp;ref_topic=2811806
https://support.google.com/docs/answer/3540681?hl=en&amp;ref_topic=1361472


Page  |  80  

APPENDIX III: WORKING WITH FORMULAS + SCRIPTING 

 
A. HOW TO USE CONDITIONAL FORMATTING 

 

Oftentimes, when you’re working in a spreadsheet, all cells start to look the same! Wouldn’t it be 

helpful if you could make them look different based on their content? (For example, highlighting 

in red all the cells that contain the word ‘no’ in a specific column). Luckily, that’s what conditional 

formatting is used for! 

 
In order to set up conditional formatting, just follow these steps: 

1. Click the ‘Format’ tab at the top of any spreadsheet 

2. Select ‘Conditional formatting… 

3. Select the appropriate statement from the first drop-down menu (depends on the 

condition you are trying to create). The options are as follows: 

a. Text contains 

b. Text does not contain 

c. Text is exactly 

d. Cell is empty 

e. Date is 

f. Date is before 

g. Date is after 

h. Greater than 

i. Less than 

j. Is equal to 

k. Is not equal to 

l. Is between 

m. Is not between 

n. Custom formula is 

4. Enter the appropriate value (either text, number, or date) into the field 

5. Select the format you would like to use - either changing the color of the text or the color 

of the cell background 

6. Choose the range to which you want to apply the conditional formatting. It could either 

be just one cell or an entire row/column of cells 

7. If you want to add another formatting condition, click ‘+ Add another rule’ 

8. Click ‘Save rules’ when you’re done! 

 
B. HOW TO WRITE FORMULAS/SCRIPTING 

Basic formula housekeeping: 

1. All formulas must begin with an equal sign 

2. All formulas must have an equal number of open and closed parentheses 

3. If you want to “lock” a reference cell or overall range, use a $ sign 

a. Example: $A2:$A100 (locks down column A reference) 

b. Example: $A$2:$A$100 (locks down both column A reference and individual cell 
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references) 

1. BEGINNER 

1. SUM - If you want to add up the contents of two or more cells. Note: the contents 

of these cells must contain numerical values rather than text. 

a.  =SUM(A2+A3) - adding contents of two cells together 

b.  =SUM(A2:A) - adding contents of multiple cells or entire column together 

2. AVERAGE - Averaging the values of a specific range 

a.  =AVERAGE(A1:A8) 

3. COUNT - If you want to count the number of items that occur in a list. Note: this 

is useful when you have text values in a series of cells rather than numerical 

values. 

a. =COUNT(A1:A8) - counting the number of independent values (note: 

NOT calculating the sum) in a specific range 

4. COUNTIF - If you want to count the number of X that fall into a certain category 

or meet certain requirements (e.g. number of females) 

a.   =COUNTIF(A1:A8, “Female”) 

5. COUNTIFS - If you want to count the number of X that meet two or more 

requirements (e.g. number of female veterans). Note that this formula requires 

referencing two different ranges, one for each criteria. 

a.   =COUNTIFS(A1:A8, “Veteran”, B1:B8, “Female”) 

6. TODAY () - Calculating the current date. Will automatically update every day. 

a.  =TODAY() 

 
2. INTERMEDIATE 

1. AGE CALCULATION - Calculating someone’s age based on their DOB 

a.  =ROUNDDOWN(DAYS360($X2,TODAY(),1)/360,0)) 

i. X refers to the column where the DOB is located 

2. ARRAY FORMULA (PART 1) - An array formula can be very valuable when you 

want to copy the exact contents of a range of cells without actually manually 

copying and pasting everything. 

a.  =ARRAYFORMULA(A1:A10) 

i. If you want to copy the contents of the range A1:A10 into another 

set of cells 

b.  =ARRAYFORMULA(A1:A) 

i. If you want to copy the contents of the entire column A range - this 

is useful when you expect there to be more data being entered in 

the future and don’t want to specify an exact end point. 

3. FILTER - The filter function can be extremely useful when you want to pull only a 

select amount of data in between tabs on the SAME spreadsheet. In other words, 

you want to filter the data as it travels from one tab to the next. If, for example, 

Tab A contained names of all dogs in the puppy show but you only wanted to 

bring over the the names of the dogs who were Dalmatians into Tab B 

a.  =FILTER('Tab A'!A2:A, 'Tab A'!A2:A="Dalmatian") 
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i. Tab A refers to the tab you want to pull data from 

ii. A2:A refers to the specific range you want to reference 

iii. “Dalmatian” refers to the criteria you want to filter for 

4. IMPORTRANGE - This formula is used to import data from another completely 

separate spreadsheet (note: NOT just another tab in the same spreadsheet). It is 

a fairly complex formula and takes significant calculation power so should be 

used relatively sparingly and only when it is necessary. 

a.  =IMPORTRANGE(“SpreadsheetURL” ; “ReferenceTab!CellRange”) 

i. Spreadsheet URL refers to the entire URL of the spreadsheet that 

you are trying to pull data FROM 

ii. Reference Tab refers to the name of the tab on that spreadsheet 

that contains the data you want to pull 

iii. Cell Range refers to the specific range of cells on that tab that you 

want to pull 

b.  Example: 

=IMPORTRANGE(“https://docs.google.com/a/cmtysolutions.org/spreadsh 

eets/d/1wtVTxj0ir3O1HdjGjFmVNGNRztD0eXVNUcUAZef31Rg/edit#gid= 

0” ; “Form Responses!A2:D100”) 

5. IF STATEMENTS - Understanding the logic behind If Statement formulas might 

be the most important one in your arsenal! We use them all the time in order to 

calculate eligibility for housing resources. However, there is no one single 

example of an If Statement so it’s easier to try to understand the basic logic 

underpinning them instead. That way, you’ll be armed with the knowledge to 

create them for any situation! Here are  few core tips: 

a. The basic structure looks like this: If A, then B. Otherwise, C. You’ll be 

filling in the ‘A’, ‘B’, and ‘C’ portions of the argument. 

b. Every If Statement takes into account both sides of an argument - if it 

does exist, then this. But if it doesn’t, then that. 

c. You can create an If statement with just one argument, like the example 

above. If A, then B. Otherwise, C. However, you can also create an If 

Statement with multiple arguments - these are called Nested If 

Statements. 

d. Nested If Statements take into account both sides of multiple arguments - 

if A exists, then B. If C exists, then D. If E exists, then F. Otherwise, G. 

e. If you want to start narrowing down a list (e.g. to determine eligibility), 

you’ll need to use Nested If Statements that begin to exclude people if 

they don’t meet certain criteria. If they pass all the test statements, then 

they are eligible. 

 
Examples: 

1. Let’s say we want to give one point to a person if they were born in the month of 

May. If not, they will get 0 points. 

a.   =IF($A2=”May”, 1, 0) 

https://docs.google.com/a/cmtysolutions.org/spreadsheets/d/1wtVTxj0ir3O1HdjGjFmVNGNRztD0eXVNUcUAZef31Rg/edit#gid%3D0
https://docs.google.com/a/cmtysolutions.org/spreadsheets/d/1wtVTxj0ir3O1HdjGjFmVNGNRztD0eXVNUcUAZef31Rg/edit#gid%3D0
https://docs.google.com/a/cmtysolutions.org/spreadsheets/d/1wtVTxj0ir3O1HdjGjFmVNGNRztD0eXVNUcUAZef31Rg/edit#gid%3D0
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2. Let’s say we only want to give a point to someone if they were born in the month 

of May and are female. This is a nested If Statement and will require us to 

exclude anyone who does not meet those criteria in order to narrow down the list. 

a.   =IF($A2<>”May”, 0, IF($B2=”Male”, 0, 1) 

b. In the formula above, each component translates to this: 

i. $A2<>”May”, 0 → If A2 does NOT equal May, give it a zero 

ii. $B2=”Male”, 0 → If B2 equals male, give it a zero 

iii. 1 → Otherwise, if neither of those are true, give it a 1 

iv. This way we end up only giving ones to females born in May! 

 
C. HOW TO COPY FORMULAS 

Knowing how to copy formulas might be one of the the most useful tools to have in your back 

pocket. It especially comes in handy when you need to replace a deleted formula! Thankfully, as 

long as you know the general basics of how to copy and paste, you’ll pick this up in no time. 

1. Make sure to open up the tab or spreadsheet that contains the formula you’d like to 

copy. Also keep open the tab or spreadsheet that contains the cell(s) you’d like to paste 

into. 

2. Go into the spreadsheet with the formula you want to copy and find the relevant formula 

you need to use. In the case of most of these spreadsheet, the majority of formulas will 

be located in Row 2. 

3. Click the cell with the relevant formula and select Control+C (Command+C if you’re on a 

Mac) or go to the Edit tab and select ‘Copy’. Multiple ways to skin a cat! 

4. Navigate to the tab/spreadsheet where you’d like to paste the copied formula and find 

the appropriate cell 

5. Use Control+V (Command+V on a Mac) or go to the Edit tab and select ‘Paste’ to paste 

down the copied formula into your new cell 

 
You’re done! Easy as pie. In some cases, you may not want to paste the formula exactly as it 

was written in the original cell, instead preferring to alter it slightly. The only reason you might 

choose to not just copy/paste and alter afterwards is if the formula is bringing over LARGE 

amounts of data that would take up significant calculation bandwidth. In this case, you may want 

to alter the formula BEFORE pasting into the new cell. Follow these easy steps to learn how to 

do that: 

1. Go into the spreadsheet with the formula you want to copy and find the relevant formula 

you need to use. In the case of most of these spreadsheet, the majority of formulas will 

be located in Row 2. 

2. Find the cell with the relevant formula and double click it so your cursor is actually sitting 

with the formula itself 

3. Highlight the entire formula EXCLUDING the equal sign 

4. Select Control+C (Command+C on a Mac) to copy the part that you have highlighted 

5. Navigate to the tab/spreadsheet where you’d like to paste the copied formula and find 

the appropriate cell 

6. Use Control+V (Command+V on a Mac) to paste down the highlighted portion of that 
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formula 

 
You’ll notice that the formula looks more like a string of long text than a real formula. This is 

what happens when you remove the equal sign! The spreadsheet no longer recognizes it as a 

real formula and proceeds to just treat it as plain text. In this format, you’re free to play around 

and alter the formula to meet your new requirements before it brings over any data. When 

you’re ready, just make sure to add the equal sign back in. 

 
Many people may not like working with a formula that doesn’t have an equal sign because the 

color coding disappears and it’s harder to differentiate among the various formula components. 

So it’s up to you to decide whatever works best! 


